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Getting Started

® “Product Overview” on page 1-2
® “Installing Required Components” on page 1-8
¢ “CAN Communication Session” on page 1-12

e “Accessing the Toolbox” on page 1-32



1 Getting Started

Product Overview

In this section...

“Getting to Know Vehicle Network Toolbox” on page 1-2
“Main Features” on page 1-2
“Interaction Between the Toolbox and Its Components” on page 1-4

“Expected Background ” on page 1-6

“Related Products” on page 1-6

Getting to Know Vehicle Network Toolbox

Vehicle Network Toolbox™ provides connectivity to CAN devices from
MATLAB® and Simulink®. The toolbox provides functions for encoding,
decoding, and filtering CAN messages, enabling you to transfer messages
between the MATLAB workspace and a CAN bus. You can use the toolbox

to run test sequences that log and record CAN messages for later analysis.
You can also use it to connect with industry-standard CAN database files and
replay recorded sequences of messages. The toolbox includes Simulink blocks
that enable you to simulate message traffic on a CAN bus or connect models
to a live network. Vehicle Network Toolbox supports CAN interface devices
from Vector, Kvaser and National Instruments®.

You can learn more about Vehicle Network Toolbox by following a simple
workflow and some easy examples. This chapter introduces the toolbox and
provides some guidelines and examples to use Vehicle Network Toolbox to
interface with the CAN bus.

Main Features

Vehicle Network Toolbox product is a collection of functions built on the
MATLAB technical computing environment.

The toolbox provides you with these main features:

e “CAN Connectivity” on page 1-3

e “Vector Device and Driver Support” on page 1-3
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e “Vehicle Network Toolbox Functions” on page 1-3
® “Simulink Library Support” on page 1-3
® “CAN Tool Interface” on page 1-4

CAN Connectivity

Vehicle Network Toolbox provides host-side CAN connectivity using defined
CAN devices. CAN is the predominant protocol in automotive electronics by
which many distributed control systems in a vehicle function.

For example, in a common design when you press a button to lock the doors
in your car, a control unit in the door reads that input and transmits lock
commands to control units in the other doors. These commands exist as data
in CAN messages, which the control units in the other doors receive and act
on by triggering their individual locks in response.

Vector Device and Driver Support

You can use Vehicle Network Toolbox with devices supported by Vector.
These devices and drivers provide a link to the CAN bus on which you can
send and receive messages.

See “Supported Hardware” on page 1-10 for more information.

Vehicle Network Toolbox Functions

Using a set of well-defined functions, you can transfer messages between the
MATLAB workspace and a CAN bus using a CAN device. You can run test
applications that can log and record CAN messages for you to process and
analyze. You can also replay recorded sequences of messages.

Simulink Library Support

With Vehicle Network Toolbox block library and other blocks from the
Simulink library, you can create sophisticated models to connect to a live
network and to simulate message traffic on a CAN bus.

1-3
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CAN Tool Interface

Using this simple graphical user interface, you can monitor message traffic on
a selected device and channel. You can then analyze these messages.

Interaction Between the Toolbox and Its Components
Vehicle Network Toolbox is a conduit between MATLAB and the CAN bus.

CAN CAN
Module Module
CAM CAN Bus CAN
Module Module
CAM CAMN
Module Device
Wehicle Netwaork
Toolbox
MATLAB

In this illustration:

e Six CAN modules are attached to a CAN bus.



Product Overview

® One module, which is a CAN device, is attached to the Vehicle Network
Toolbox, built on the MATLAB technical computing environment.
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Using Vehicle Network Toolbox from MATLAB, you can configure a channel
on the CAN device to:

® Transmit messages to the CAN bus.

® Receive messages from the CAN bus.

® Trigger a callback function to run when the channel receives a message.

e Attach the database to the configured CAN channel to interpret received
CAN messages.

e Use the CAN database to construct messages to transmit.
¢ Log and record messages and analyze them in MATLAB.
e Replay live recorded sequence of messages in MATLAB.

® Build Simulink models to connect to a CAN bus and to simulate message
traffic.

® Monitor message traffic with the CAN Tool.
Vehicle Network Toolbox is a comprehensive solution for CAN connectivity in

MATLAB and Simulink. Refer to the function and block chapters for more
information.

Expected Background

This document assumes that you are familiar with these products:

¢ MATLAB — To write scripts and functions, and to use functions with the
command-line interface.

e Simulink — To create simple models to connect to a CAN bus or to simulate
those models.

e Vector CANdb — To understand CAN databases and message and signal
definitions.

Related Products

MathWorks provides several products that are relevant to the kinds of tasks
you can perform with Vehicle Network Toolbox software and that extend the
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capabilities of MATLAB. For information about these related products, see
the toolbox product page on the MathWorks Web site.
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Installing Required Components

In this section...

“Required Components” on page 1-8
“Installing Devices and Drivers” on page 1-8

“Installing the Toolbox” on page 1-10

“Supported Hardware” on page 1-10

Required Components

To communicate on CAN networks from the MATLAB workspace and using
Simulink models, install these components:

e Current MATLAB version
e Current Vehicle Network Toolbox software

e Hardware, drivers, and driver libraries for your devices

Note To use the Vehicle Network Toolbox block library, install the current
Simulink version.

Installing Devices and Drivers

® “Vector Hardware Devices and Drivers” on page 1-8
e “Kvaser Hardware Devices and Drivers” on page 1-9

e “National Instruments Devices and Drivers” on page 1-10

Vector Hardware Devices and Drivers

You need the latest version of the XL Plug & Play drivers for your device to
use with Windows® XP, Windows Vista™, or Windows 7.
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The documentation from Vector provides installation instructions for
hardware devices such as CANcaseXL, CANboardXL, and CANcardXL,
drivers, and support libraries.

These drivers are available for download from the Vector Web site at:
https://www.vector-worldwide.com/va_downloadcenter_us.html.

Drivers for 32-bit and 64-bit Windows are available in separate packages.
Download and install the latest version and check the appropriate box during
the installation for the hardware you want to use. Virtual channels are also
installed with the hardware drivers.

Installing the XL Driver Library. Download and install the latest version of
the XL Driver Library from the Vector Web site. A single package contains
the driver library for 32-bit and 64-bit Windows. After you install the library:

¢ If you have a 32-bit system, copy the file vxlapi.dll from the installation
folder to the windows root\system32 folder.

e If you have a 64-bit system you can run the 32-bit version of Vehicle
Network Toolbox software. Copy the vxlapi.dll from the installation
folder to the windows root\syswow64 folder.

Kvaser Hardware Devices and Drivers
You need the latest version of the driver for your device to use with Windows

XP, Windows Vista, or Windows 7. Refer to your Kvaser device documentation
for hardware installation instructions.
Drivers for your Kvaser devices are available on the Kvaser Web site at:

http://www.kvaser.com/download/main.php

Drivers for 32-bit and 64-bit Windows are available in the same package.
Virtual channels are also installed with the hardware drivers.

Installing the Driver Library. The Kvaser Driver Library, can1ib32.d11 is

installed along with the driver, and is automatically saved in the windows
system32 or syswow64 folder.

1-9
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National Instruments Devices and Drivers

You need the latest version of the driver for your device to use with Windows
XP, Windows Vista, or Windows 7. Refer to your National Instruments device
documentation for hardware installation instructions.

Install the NI CAN programming library from the National Instruments Web
site. This will install both the drivers and the driver libraries.

Drivers for 32-bit and 64-bit Windows are available in the same package.
Virtual channels are also installed with the hardware drivers.

Installing the Driver Library. When you install the NI CAN programming
library, the nican.dll is automatically saved in the windows system32 or
syswow64 folder.

Installing the Toolbox

Determine if Vehicle Network Toolbox software is installed on your system by
typing the following in the MATLAB Command Window:

ver

The Command Window displa ys information about the MATLAB version you
are running, including a list of installed add-on products and their version
numbers. Check the list to see if Vehicle Network Toolbox name appears.

For information about installing the toolbox, refer to the installation
documentation for your platform. If you experience installation difficulties,
look for the installation and license information at the MathWorks Web site:
http://www.mathworks.com/support

Supported Hardware

Vehicle Network Toolbox supports Vector, Kvaser, and National Instruments
CAN devices.

Supported Vector Devices

¢ CANcaseXL


http://www.ni.com/drivers/
http://www.mathworks.com/support

Installing Required Components

* CANcaseXLe

¢ CANboardXL

® CANboardXL pxi
¢ CANboardXL PCle
¢ CANcardXL

® CANcardX

You can also use the toolbox with virtual CAN channels available with Vector
hardware drivers.

Supported Kvaser Devices
Support for Kvaser CAN devices, including these product families:

e WLAN
PCMCIA
Leaf

e Memorator
e PCI
e USB

You can also use the toolbox with virtual CAN channels available with Kvaser
hardware drivers.

For a full list of devices, see the Supported Hardware page.

Supported National Instruments Devices
For a complete list of supported NI CAN devices, see the Supported Hardware
page

1-11
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CAN Communication Session
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In this section...

“CAN Communication in MATLAB” on page 1-12
“Typical CAN Workflow” on page 1-13
“Prerequisites” on page 1-14

“Checking for the Installed CAN Hardware” on page 1-14
“Creating a CAN Channel Object” on page 1-15
“Configuring Properties” on page 1-16

“Starting the Configured Channel” on page 1-18
“Creating a Message Object” on page 1-18
“Packing a Message” on page 1-20

“Transmitting a Message” on page 1-21

“Receiving a Message” on page 1-22

“Unpacking a Message” on page 1-23

“Saving and Loading a CAN Channel” on page 1-23
“Configuring Message Filtering” on page 1-24
“Configuring Multiplexing” on page 1-25
“Configuring Silent Mode” on page 1-28

“Disconnecting Channels and Cleaning Up” on page 1-29

CAN Communication in MATLAB

This section takes you through the workflow for connecting to a CAN device
and then communicating with the CAN bus.

The subsequent sections map to the following CAN workflow chart.
Subsequent sections also provide interconnected code examples. You can

use these examples and try them sequentially to understand how the
communication works.
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Typical CAN Workflow

Create a CAN | canch =
channel canChannel ( "Vector’ ' CANcaseXL 1',1)
. J
Configure
channel configBusSpeed (canch, 250000)
properlies
. J
Start oonﬁgur‘ad start (canch)
channel
Transmitting Transmitting Receiving
or receiving
messages’?
¥ k4
Build a msglut = Receive »
| %
message canMessage (500, false, &) messages msgIn =
receive (canch, 1)
Mew
A 4 Y
New or same™._ ™ | pack message | pack (msgout, Extract <assorted functions>
massaga? with data 25,0,186, "'LittleEndian’) messages like extracthll
.
A 4 Y
0 value = unpack (msglIn,
Transmit a transmit{canch, msgout) Unpack data 0,16,
Message from messages ‘LittleEndian’,
l ‘intlE")
More to Done with ™~ Mo More to Yes
transmit? channel? receive?
Yes
Disconnect the
channel stop (canch)
¥ 1-13
Clean up
MATLAB clear
workspace
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The following sections provide a sequential workflow for configuring CAN
communications. You can use the provided examples and try them in a
MATLAB Command Window to follow along.

The examples create two CAN channel objects using the canHWInfo function
to obtain information about the devices installed on your system. You edit the
properties of the first channel and create a message using the canMessage

function. You transmit the message from the first channel using the transmit
function, and receive it on the other using the receive function.

Prerequisites
Before you follow this example, make sure you:

* Complete your toolbox installation before you try out the examples.

® Connect the two channels in your CAN device with a loopback connector.

The following examples use the Vector CANcaseXL hardware. You can
substitute 1t with any other supported hardware.

Checking for the Installed CAN Hardware

1 Get information about the CAN hardware devices on your system:

info = canHWInfo

MATLAB displays the following information:

CAN Devices Detected

Vendor | Device | Channel | Serial Number | Constructor

Kvaser | Virtual 1 | 1 | 0 | canChannel('Kvaser', 'Virtual 1', 1)
Kvaser | Virtual 1 | 2 | 0 | canChannel('Kvaser', 'Virtual 1', 2)
NI | Virtual (CAN256) | 1 | 0 | canChannel('NI', 'CAN256')

NI | Virtual (CAN257) | 2 | 0 | canChannel('NI', 'CAN257')

NI | Series 847X Sync USB (CANO) | 1 | 14E1B6E | canChannel('NI', 'CANO')

NI | Series 847X Sync USB (CAN1) | 1 | 14E1B68 | canChannel('NI', 'CAN1')

Vector | CANcaseXL 1 | 1 | 24365 | canChannel('Vector', 'CANcaseXL 1', 1)

1-14
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Vector | CANcaseXL 1 | 2 | 24365 | canChannel('Vector', 'CANcaseXL 1', 2)
Vector | Virtual 1 | 1 | 0 | canChannel('Vector', 'Virtual 1', 1)
Vector | Virtual 1 | 2 | 0 | canChannel('Vector', 'Virtual 1', 2)

Use GET on the output of CANHWINFO for more information.

2 Get details about all available CAN channels by typing:

info.VendorInfo(1).ChannelInfo(1)

3 Press Enter. MATLAB displays information such as:

can.vector.ChannelInfo handle
Package: can.vector

Properties:
Device: 'CANcaseXL 1'
DeviceChannelIndex: 1
DeviceSerialNumber: 24365
ObjectConstructor: 'canChannel('Vector', 'CANcaseXL 1',1)"

Creating a CAN Channel Object

Note This example assumes that you have a loopback connection between
the two channels on your CAN device.

1 Create the first CAN channel on an installed CAN device:

canch1i = canChannel('Vector', 'CANcaseXL 1',1)

Notes You cannot use the same variable to create multiple channels
sequentially. Clear any channel in use before using the same variable
to construct a new CAN Channel.

You cannot create arrays of CAN channel objects. Each object you create
must exist as its own individual variable.

1-15
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2 Press Enter after you create the connection. MATLAB displays a summary
of the channel properties:

Summary of CAN Channel using 'Vector' 'CANcaseXL 1' Channel 1.

Channel Parameters: Bus Speed is 500000.
Bus Status is 'N/A'.
Transceiver name is 'CANpiggy 251mag (Highspeed)'.
Serial Number of this device is 24811.
Initialization access is allowed.

No database is attached.

Status: Offline - Waiting for START.
0 messages available to RECEIVE.
0 messages transmitted since last start.

0 messages received since last start.
Filter History: Filters are open for Standard and Extended IDs.

3 Create a second CAN channel object.

canch2 = canChannel('Vector', 'CANcaseXL 1',2)

You used the canChannel function to connect to the CAN device. To identify
installed devices, use the canHWInfo function.

Configuring Properties

You can set the behavior of your CAN channel by configuring its property
values. For this exercise, change the bus speed of channel 1 to 250000 using
the configBusSpeed function.

Tip Configure property values before you start the channel.

1 Display the properties on canch1:

get(cancht)

MATLAB displays all properties on the configured channel:

1-16
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General Settings:
BusStatus = 'N/A'
Database = []
InitializationAccess = 1
MessageReceivedFcn = []
MessageReceivedFcnCount = 1
MessagesAvailable = 0
MessagesReceived = 0
MessagesTransmitted =
ReceiveErrorCount = 0
Running = 0
SilentMode = 0
TransmitErrorCount = 0

0

Device Settings:

Device = 'CANcaseXL 1'
DeviceChannellIndex = 1
DeviceSerialNumber = 24811
DeviceVendor = 'Vector'

Transceiver Settings:
TransceiverName = 'CANpiggy 251mag (Highspeed)'
TransceiverState = 16

Bit Timing Settings:
BusSpeed = 500000

SJw = 1
TSEG1 = 4
TSEG2 = 3

NumOfSamples = 1
2 Change the BusSpeed property of the channel to 250000:
configBusSpeed(canch1, 250000)
3 To see the changed property value, type:
get(canchi)

MATLAB displays all properties on the configured channel as before, with
the changed BusSpeed property value:
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BusSpeed = 250000

4 Change the bus speed of the second channel (canch2) by repeating steps
2 and 3.

Starting the Configured Channel

Start your CAN channels after you configure all properties.

1 Start the first channel:

start(cancht)

2 Start the second channel:

start(canch2)

3 To check that the channel is online, type the channel name in the Command
Window. The Status section indicates that the channel is now online, as
in this example:

>> canchi

Status: Online.
0 messages available to RECEIVE.
0 messages transmitted since last start.

0 messages received since last start.

Filter History: Filters are open for Standard and Extended IDs.

Creating a Message Object

After you set all the property values as desired and your channels are online,
you are ready to transmit and receive messages on the CAN bus. For this
exercise, transmit a message using canch and receive it using canch1. To
transmit a message, create a message object and pack the message with the
required data.

1-18
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1 Build a CAN message of ID 500 of standard type and a data length of
8 bytes:

messageout = canMessage (500, false, 8)

The message object is now:

messageout =

can.Message handle
Package: can

Properties:
ID: 500
Extended: 0O
Name: "'
Database: []
Error: 0O
Remote: O

Timestamp: O
Data: [0 0 0 0 0 0 0 0]
Signals: []

Methods, Events, Superclasses
The fields in the message show:

e can.Message (Normal Frame) — Specifies that the message is not an
error or a remote frame.

e ID — The ID you specified and its hexadecimal equivalent.

¢ Extended — A logical 0 (false) because you did not specify an extended ID.

e Data — A uint8 array of Os specified by the data length.

Refer to the canMessage function to understand more about the input
arguments.

You can also use a database to create a CAN message. Refer to Using a CAN
Database for more information.
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Packing a Message
After you define the message, pack it with the required data.

1 Use the pack function to pack your message with these input parameters:

pack(messageout, 25, 0, 16, 'LittleEndian')

Here you are specifying the data value to be 25, the start bit to be 0, the
signal size to be 16, and the byte order to be little-endian format.

2 To see the packed data, type:

messageout
MATLAB displays your message properties with the specified data:
messageout =

can.Message handle
Package: can

Properties:
ID: 500
Extended: 0O
Name: ‘"'
Database: []
Error: O
Remote: O

Timestamp: 0
Data: [25 0 0 0 0 O O O]
Signals: []

Methods, Events, Superclasses

The only field that changes after you specify the data is Data. Refer to the
pack function to understand more about the input arguments.
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Transmitting a Message

After you define the message and pack it with the required data, you are
ready to transmit the message. For this example, use canch to transmit the
message.

1 Use the transmit function to transmit the message, supplying the channel
and the message as input arguments:

transmit(canch1, messageout)

2 To display the channel status, type:

canch1

MATLAB displays the updated status of the channel:

Summary of CAN Channel using 'Vector' 'CANcaseXL 1' Channel 1.

Channel Parameters: Bus Speed is 250000.
Bus Status is 'ErrorPassive'.
Transceiver name is 'CANpiggy 251mag (Highspeed)'.
Serial Number of this device is 24811.
Initialization access is allowed.

No database is attached.
Status: Online.
1 messages available to RECEIVE.
1 messages transmitted since last start.

0 messages received since last start.

Filter History: Filters are open for Standard and Extended IDs.

In the Status section, messages transmitted since last start count
increments by 1 each time you transmit a message.

Refer to the transmit function to understand more about the input
arguments.
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Receiving a Message

After your channel is online, use the receive function to receive available
messages. For this example, receive the message on the second configured
channel object, canch2

1 To see messages available to be received on this channel, type:

canch2

The channel status displays available messages:

Status: Online.
1 messages available to RECEIVE.
0 messages transmitted since last start.

0 messages received since last start.
2 To receive one message from canchi1 and store it as messagein, type:
messagein = receive(canch2, 1)
MATLAB returns the received message properties:
messagein =

can.Message handle
Package: can

Properties:
ID: 500
Extended: 0
Name: "'
Database: []
Error: O
Remote: O

Timestamp: 709.0403
Data: [25 0 0 0 0 0 0 O]
Signals: []
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Methods, Events, Superclasses

3 To check if the channel received the message, type:

canch2

MATLAB returns the channel properties, and the status indicates that
the channel received one message:

Status: Online.
0 messages available to RECEIVE.
0 messages transmitted since last start.
1 messages received since last start.

Refer to the receive function to understand more about its input arguments.

Unpacking a Message

After your channel receives a message, specify how to unpack the message
and interpret the data in the message. Use unpack to specify the parameters
for unpacking a message:

value = unpack(messagein, 0, 16, 'LittleEndian', 'int16')
The unpacked message returns a value based on your parameters:

value =

25

Refer to the unpack function to understand more about its input arguments.

Saving and Loading a CAN Channel

¢ “Saving a CAN Channel Object to a MATLAB File” on page 1-24
® “Loading a Saved CAN Channel” on page 1-24
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Saving a CAN Channel Object to a MATLAB File

You can save a CAN channel object to a file using the save function anytime
during the CAN communication session.

For example, create a channel object canch1. To save it to the MATLAB
file mycanch.mat, type:

save mycanch.mat canchi

Loading a Saved CAN Channel

If you have saved a CAN channel as a MATLAB file, you can load it into a
session using the load function. For example, to reload mycanch.mat created
above, type:

load mycanch.mat

The loaded CAN channel object reconnects to the specified hardware and
reconfigures itself to the specifications when the channel was saved.

Configuring Message Filtering

You can set up filters on your channel to accept messages based on the filtering
parameters you specify. Set up your filters before putting your channel online.
For more information on message filtering, see these functions:

e filterAcceptRange

filterBlockRange

filterReset
e filterSet

To specify a range of message IDs that you want the channel to accept, type:

stop(canchi)
filterAcceptRange(canchi, 500, 625)

Now you can build a message, and then pack, transmit, receive, and unpack
it. If you display your channel settings, you see the status of the message
filters on it.
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canch1

Summary of CAN Channel using 'Vector' 'CANcaseXL 1' Channel 1.

Filter History: Filters are open for Standard and Extended IDs.
Block Range added. Starting ID: 0 Ending ID: 2047
Accept Range added. Starting ID: 500 Ending ID: 625

Configuring Multiplexing

Use multiplexing to represent multiple signals in one signal’s location in a
CAN message’s data. A multiplexed message can have three types of signals:

Standard signal
This signal is always active. You can create one or more standard
signals.

Multiplexor signal
Also called the mode signal, it is always active and its value determines
which multiplexed signal is currently active in the message data. You
can create only one multiplexor signal per message.

Multiplexed signal
This signal is active when its multiplex value matches the value of the
multiplexor signal. You can create one or more multiplexed signals in
a message.

Multiplexing works only with a CAN database with message definitions that
already contain multiplex signal information. This example shows you how to
access the different multiplex signals using a database constructed specifically
for this purpose. This database has one message with these signals:

® SigA: A multiplexed signal with a multiplex value of 0.

® SigB: Another multiplexed signal with a multiplex value of 1.

® MuxSig: A multiplexor signal, whose value determines which of the two
multiplexed signals are active in the message.

1 Create a CAN database:

d = canDatabase('Mux.dbc')
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Note This is an example database constructed for creating multiplex
messages. To try this example, use your own database.

2 Create a CAN message:
m = canMessage(d, 'Msg')
The message displays all its properties:
m =

can.Message handle
Package: can

Properties:
ID: 250
Extended: 0
Name: 'Msg'
Database: [1x1 can.Database]
Error: 0
Remote: 0

Timestamp: 0
Data: [0 00 0 0 0 0 0]
Signals: [1x1 struct]
Methods, Events, Superclasses

3 To display the signals, type:

m.Signals
ans =
SigB: 0
SigA: 0
MuxSig: O

MuxSig is the multiplexor signal, whose value determines which of the
two multiplexed signals are active in the message. SigA and SigB are the
multiplexed signals that are active in the message if their multiplex values
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match MuxSig. In the example shown, SigA is active because its current
multiplex value of 0 matches the value of MuxSig (which is 0).

4 If you want to make SigB active, change the value of the MuxSig to 1:

m.Signals.MuxSig = 1

To display the signals, type:

m.Signals
ans =
SigB: 0
SigA: 0
MuxSig: 1

SigB is now active because its multiplex value of 1 matches the current
value of MuxSig (which is 1).

5 Change the value of MuxSig to 2:

m.Signals.MuxSig = 2

Here, neither of the multiplexed signals are active because the current
value of MuxSig does not match the multiplex value of either SigA or SigB.

m.Signals
ans =
SigB: 0
SigA: 0
MuxSig: 2

Always check the value of the multiplexor signal before using a multiplexed
signal value.

if (m.Signals.MuxSig == 0)

% Feel free to use the value of SigA however is required.
end
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This ensures that you are not using an invalid value because the toolbox
does not prevent or protect reading or writing inactive multiplexed signals.

Note You can access both active and inactive multiplexed signals regardless
of the value of the multiplexor signal.

Refer to the canMessage function to learn more about creating messages.

Configuring Silent Mode

The SilentMode property of a CAN channel specifies that the channel can
only receive messages and not transmit them. Use this property to observe all
message activity on the network and perform analysis without affecting the
network state or behavior. See SilentMode for more information.

1 Create a CAN channel object canch and display its properties:

get(canchi)

MATLAB displays all properties on the configured channel:

General Settings:
BusStatus = 'N/A'
Database = []
InitializationAccess = 1
MessageReceivedFcn = []
MessageReceivedFcnCount = 1
MessagesAvailable = 0
MessagesReceived = 0
MessagesTransmitted = 0
ReceiveErrorCount = 0
Running = 0
SilentMode = 0
TransmitErrorCount = 0

Device Settings:
Device = 'CANcaseXL 1'
DeviceChannellIndex = 1
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DeviceSerialNumber = 24811
DeviceVendor = 'Vector'

Transceiver Settings:
TransceiverName = 'CANpiggy 251mag (Highspeed)'
TransceiverState = 16

Bit Timing Settings:
BusSpeed = 500000

SJw = 1
TSEG1 = 4
TSEG2 = 3

NumOfSamples = 1

2 Change the SilentMode property of the channel to true:

canch1.SilentMode = true

3 To see the changed property value, type:

get(canchi)

MATLAB displays all properties on the configured channel as before, with
the changed SilentMode property value:

SilentMode = 1

Disconnecting Channels and Cleaning Up

e “Disconnecting the Configured Channel” on page 1-30

e “Cleaning Up the MATLAB Workspace” on page 1-30

1-29



1 Getting Started

Disconnecting the Configured Channel

When you no longer need to communicate with your CAN bus, disconnect the
CAN channel that you configured. Use the stop function to disconnect.

1 Stop the first channel:

stop(canchi)

2 Check the channel status:

canch1

MATLAB displays the channel status:

Status: Offline - Waiting for START.
1 messages available to RECEIVE.
1 messages transmitted since last start.

0 messages received since last start.
3 Stop the second channel:

stop(canch2)

4 Check the channel status:

canch2

MATLAB displays the channel status:

Status: Offline - Waiting for START.
0 messages available to RECEIVE.
0 messages transmitted since last start.

1 messages received since last start.

Cleaning Up the MATLAB Workspace

When you no longer need the objects you used, remove them from the
MATLAB workspace. To remove channel objects and other variables from the
MATLAB workspace, use the clear function.

1-30



CAN Communication Session

1 Clear the first channel:

clear canchi

2 Clear the second channel:

clear canch2

3 Clear the CAN messages:

clear('messageout', 'messagein')

4 (Clear the unpacked value:

clear value
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Accessing the Toolbox
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In this section...

“Exploring the Toolbox” on page 1-32
“Getting Help” on page 1-32

“Viewing Examples” on page 1-32

Exploring the Toolbox

You can access Vehicle Network Toolbox from the MATLAB Command
Window directly by using any Vehicle Network Toolbox function. To see a list
of all the functions available, type:

help vnt

Getting Help

The toolbox functions are grouped by usage. Click a specific function for more
information.

To access the online documentation for the Vehicle Network Toolbox, type:

doc vnt

To access the reference page for a specific function, type:

doc function_name

Viewing Examples

To follow examples in this guide use the Vector CANcaseXL device, with the
Vector XL Driver Library version 6.4 or later. The Examples index in the
Help browser lists these examples.
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* “Vector CANdb Support” on page 2-2
® “Loading and Creating Messages Using the .dbc File” on page 2-3
® “Other Uses of the CAN Database” on page 2-6
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Vector CANdb Support

Vehicle Network Toolbox supports the use of a Vector CAN database. A .dbc
file contains definitions of CAN messages and signals.

Use Vehicle Network Toolbox to look up message and signal information and
build messages using the information defined in the database file.
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Loading and Creating Messages Using the .dbc File

In this section...
“Loading the CAN Database” on page 2-3

“Creating a CAN Message” on page 2-3
“Accessing Signals in the Constructed CAN Message” on page 2-4
“Adding a Database to a CAN Channel” on page 2-4

“Updating Database Information” on page 2-5

Loading the CAN Database

To use a CANdDb file, load the database into your MATLAB session. At the
MATLAB command prompt, type:

db = canDatabase(’filename.dbc’)

Here db is a variable you chose for your database handle and filename. dbc is
the actual file name of your CAN database. If your CAN database is not in the
current working directory, type the path to the database:

db = canDatabase(’path\filename.dbc’)

Tip CAN database file names containing non-alphanumeric characters such
as equal signs, ampersands, and so forth are incompatible with Vehicle
Network Toolbox. You can use periods in your database name. Rename any
CAN database files with non-alphanumeric characters before you use them.

This command returns a database object that you can use to create and
interpret CAN messages using information stored in the database. Refer to
the canDatabase function for more information.

Creating a CAN Message

This example shows you how to create a message using a database
constructed specifically for a demo. You can access this database in the
Toolbox > VNT > VNTDemos subfolder in your MATLAB installation
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folder. This database has a message, EngineMsg. To try this example, create
messages and signals using definitions in your own database.

1 Create the CAN database object:
d = canDatabase('demoVNT_CANdbFiles.dbc')

2 Create a CAN message using the message name in the database:
message = canMessage(d, 'EngineMsg')

Accessing Signals in the Constructed CAN Message

You can access the two signals defined for the message you created in the
example database, message. You can also change the values for some signals.

1 To display signals in your message, type:
sig = (message.Signals)
Signals in the message are displayed as follows:
sig =

VehicleSpeed: 0
EngineRPM: 250

2 Change the value of the EngineRPM signal:

message.Signals.EngineRPM = 300

3 Display signal information again to see the change:
sig
sig =

VehicleSpeed: 0
EngineRPM: 300

Adding a Database to a CAN Channel
To add a database to the CAN channel canch, type:
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canch.Database = canDatabase('Mux.dbc')

For more information, see the Database property.
Updating Database Information
When you make changes to a database file:

1 Reload the database file into your MATLAB session using the canDatabase
function.

2 Reattach the database to messages using the attachDatabase function.
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Other Uses of the CAN Database

In this section...

“Viewing Message Information in the CAN Database” on page 2-6

“Viewing Signal Information in a CAN Message” on page 2-7

“Attaching a CAN Database to Existing Messages” on page 2-7

Viewing Message Information in the CAN Database

You can get information about the definition of messages in the database,
a single message by name, or a single message by ID. To get message
information about all messages in the database, type:

msgInfo = messageInfo(database name)

This command returns the message structure of information about messages
in the database. For example:

msgInfo =

5x1 struct array with fields:
Name
Comment
ID
Extended
Length
Signals

To get information about a single message by message name, type:

msgInfo = messagelnfo(database name, 'message name')

This command returns information about the message as defined in the
database. For example:

msgInfo = messageInfo(db, 'EngineMsg')

msgInfo =
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Name: 'EngineMsg’

Comment: '
ID: 100

Extended: 0O

Length: 8

Signals: {2x1 cell}

Here the function returns information about message with name EngineMsg
in the database db. You can also use the message ID to get information
about a message. For example, to view the example message given here by
inputting the message 1D, type:

msgInfo = messageInfo(db, 100, false)

This command provides the database name, the message ID, and a Boolean
value for the extended value of the ID.

To learn how to use it and work with the database, see the messageInfo
function.

Viewing Signal Information in a CAN Message

You can get information about all signals in a CAN message. Provide the
message name or the ID as a parameter in the command.:

sigInfo = signalInfo(db, 'EngineMsg')

You can also get information about a specific signal by providing the signal
name:

sigInfo = signalInfo(db, 'EngineMsg', 'EngineRPM')

To learn how to use this property and work with the database, see the
signalInfo function.

Attaching a CAN Database to Existing Messages

You can attach a .dbc file to messages and apply the message definition
defined in the database. Attaching a database allows you to view the
messages in their physical form and use a signal-based interaction with the
message data.
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To attach a database to a message, type:

attachDatabase (message name, database name)

Note If your message is an array, all messages in the array are associated
with the database that you attach.

You can also dissociate a message from a database so that you can view the
message in its raw form. To clear the attached database from a message, type:

attachDatabase (message name, [])

Note The database gets attached even if the database does not find the
specified message. Even though the database is still attached to the message,
the message is displayed in its raw mode.

For more information, see the attachDatabase function.
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CAN Tool

In this section...

“About the CAN Tool” on page 3-2
“Opening the CAN Tool” on page 3-2
“CAN Tool Fields” on page 3-2

About the CAN Tool

Vehicle Network Toolbox provides a graphical user interface that monitors
CAN message traffic on selected channels. Using the CAN Tool you can:

® view live CAN message data.

® (Configure connection to the CAN bus.

* View unique messages.

Attache a database to view signal information.

Save the messages to a log file.

You can

Opening the CAN Tool
To open the CAN Tool, type canTool in the MATLAB Command Window.

CAN Tool Fields

The tool has the following menus, buttons and table.
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File Menu

* Save Messages — Saves messages to a log file.
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® (Clear Messages — Clears messages in the CAN Tool window.

e Exit — Click to exit the CAN Tool window.

Configure Menu
¢ Channel — Displays all available CAN devices and channels on your
system. Select the CAN channel to monitor.

®* Bus Speed — Opens the Specified bus speed dialog box. To change the
bus speed of the selected channel, type the new value in bits per second in
the box.

i

Entar the bus s in_bits par second:

Ok Cancel |

® Message Filters — Opens the Set Message Filters dialog box. Select an
option in the dialog box to configure hardware filters to block or allow
messages.

= Standard Message ID Filter
« Allow All — Select to allow all standard ID messages.
Block All — Select to block all standard ID messages.

+ Allow only — Select to set up custom filtering of messages. Type the
standard message IDs that you want to allow.

= Extended Message ID Filter
+ Allow All — Select to allow all extended ID messages.
Block All — Select to block all extended ID messages.

+ Allow only — Select to set up custom filtering of messages. Type the
extended message IDs that you want to allow.
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* Database — Selects the database to attach to the CAN messages on the

selected channel.

Run Menu

e Start — Click to view message activity on the selected channel.

¢ Pause — Click to pause the display of message activity on the selected

channel.

® Stop — Click to stop the display of message activity on the selected

channel.

View Menu

¢ Maximum message count — Opens the Specify maximum message count

dialog box. To change the maximum number of messages displayed at a
time in the CAN Tool, type the new value in the box.

) Specify maximum messa

=101

Entar the maximum number of massagas to display as

a value betwean 50 and 5000;

OK

Cancel

® Number Format — Select the number format to display message
identifier data. Choose Hexadecimal or Decimal.

® Show Unique Messages — Select this option to display the most recent

instance of each message received on the selected channel. If you select

this option, the tool displays a simplified version of the message traffic. In

this view, messages do not scroll up, but each message refreshes its data

with each timestamp. If you do not select this option, the tool displays all

instances of all messages in the order that the selected channel receives

them.
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Help Menu

e canTool Help — Select this option to see the online help for CAN Tool.

®* About Vehicle Network Toolbox — Select this option to view the toolbox
version and release information.

Buttons

®

Displays message activity on the selected channel.

Pause @
Pauses the display of message activity on the selected channel.

@

Stops displaying messages on the selected channel.

Start

Stop

Save messages
Click this button to save the current message list on the selected
channel to a file.

Clear messages

Click this button to clear messages in the CAN Tool window.

=]

Show unique messages =&
Select this option to display the most recent instance of each message
received on the selected channel. If you select this option, the tool
displays a simplified version of the message traffic. In this view,
messages do not scroll up, but each message refreshes its data with each
timestamp. If you do not select this option the tool displays all instances
of all messages in the order that the selected channel receives them.

Docking
Click this button to dock the CAN Tool to the MATLAB desktop. To

undock, click this button i
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Undocking
Click this button to undock the CAN Tool from the MATLAB desktop.

To dock, click this button. g

Message Table

Timestamp
Displays the time, relative to the start time, that the device receives the
message. The start time begins at 0 when you click Start.

ID

Displays the message ID. This field displays a number in hexadecimal
format for the ID and:

¢ Displays numbers only for standard IDs.

® Appends an x for an extended ID.

¢ Displays an r for a remote frame.

¢ Displays error for messages with error frames.

To change the format to decimal, select View > Number
Format > Decimal.

Name
Displays the name of the message, if available.

Length
Displays the length of the message in bytes.

Data
Displays the data in the message in hexadecimal format.

To change the format to decimal, select View > Number
Format > Decimal.

If you are using a database, click the + sign to see signal information. The tool
displays the signal name and the physical value of the message, as defined in
the attached database.
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Using the CAN Tool

In this section...

“Viewing Messages on a Channel” on page 3-8
“Configuring the Channel Bus Speed” on page 3-8
“Filtering CAN Messages in the CAN Tool” on page 3-9
“Attaching a Database” on page 3-10

“Changing the Message Count” on page 3-12
“Changing the Number Format” on page 3-12
“Viewing Unique Messages” on page 3-12

“Saving the Message Log File” on page 3-13

Viewing Messages on a Channel

1 Open the CAN Tool and select the device and channel connected to your
CAN bus by selecting Configure > Channel.

2 The CAN Tool defaults to the bus speed set in the device driver. You can
also configure a new bus speed. See Configuring the Channel Bus Speed

3 Click Start, or select Run > Start.
4 To pause the display, click Pause or select Run > Pause.

5 To stop the display, click Stop or select Run > Stop.

Configuring the Channel Bus Speed

Configure the bus speed when your network speed differs from the default
value of the channel. You require initialization access for the channel to
configure the bus speed.

To configure a new bus speed:

1 Select Configure > Bus Speed.

3-8



Using the CAN Tool

2 Type the desired value in the Specify bus speed dialog box.
3 Click OK.

The value you set takes effect once you start the CAN channel. If an error
occurs when applying the new bus speed, the value reverts to the default
value specified in the hardware.

Filtering CAN Messages in the CAN Tool
Filter CAN messages to allow or block messages displayed in the CAN Tool.

To set up filters:

1 Select Configure > Message Filters.

2 To set filters on standard message IDs, select:

a Allow All to set the hardware filter to allow all messages with standard
IDs.

b Block All to set the hardware filter to block all messages with standard
IDs.

¢ Allow Only to set up custom filters. Type the standard IDs of the
message you want to filter. You can type a range or single IDs. The
default is 0:2047.
3 To set filters on extended message IDs, select:
a Allow All to set the hardware filter to allow all messages extended IDs.

b Block All to set the hardware filter to block all messages extended IDs.

¢ Allow Only to set up custom filters. Type the extended IDs of the
message you want to filter. You can type a range or single IDs. The
default is 0:536870911.

Note If you are using a custom filter, change the default range to the
desired range. The default range allows all messages and you should
select Allow All to allow all incoming messages with extended IDs.
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4 Click OK.

Attaching a Database
Attach a database to the CAN Tool to see signal information of the displayed

messages.

1 Select Run > Stop to stop the message display in the CAN Tool.

2 Select Configure > Database.

3 Select the database to attach and start the message display again.

When the tool displays the messages, it shows the message name in the

Message table.
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4 Click the plus (+) sign to see the details of the message.
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4,987063 Y T— 54 6C 45 32
[=] 4.986085 1F4 TestMessage 4 AEB47105
|_ Signal Mame Physical Value
Sigl 174.000000
Sig2 130,000000
Sig3 113.000000
Sigd 5.000000

The tool displays the signal name as defined in the attached database and
the signal’s physical value.

Changing the Message Count

You can change the maximum number of messages displayed to a value from
100 through 5000.

1 Select View > Maximum Message Count.

2 In the Specify maximum message count dialog box, type the number of
messages you want displayed at one time.

3 Click OK.

Changing the Number Format

By default the message data is displayed in hexadecimal format. To change
the display to decimal format, select View > Number Format > Decimal.

Viewing Unique Messages

To view the most recent instance of each unique message received on the
channel, select View > Show Unique Messages. In this view, you do not
see messages scroll up, but each message refreshes its data and timestamp

Sl
with each new instance. You can also click = ==,
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) canTool | Vector - CANcaseXL 1 - Channel 1 | Started - 500 kbps _|D|ﬂ
File Configure Run View Help £
BE@O|HO|®

Timestamp D Mame Length Data
11.575509 DE 94 8C 25

11.570291 2EE 8 JAESZYD3BIFEL..

Use this feature to get a snapshot of message IDs that the selected channel
receives. Use this information to analyze specific messages.

When you select Show Unique Messages, the tool continues to receive
message actively. This simplified view allows you to focus on specific
messages and analyze them.

To save messages when Show Unique Messages is selected, click Pause
and then click Save. You cannot save just the unique message list. This
operation saves the complete message log in the window.

Saving the Message Log File

You can save a log file of the messages currently displayed while the tool is
running. You need not stop or pause the display to save a log file.

To save a log file of the messages currently displayed in the window, select
File > Save Messages or click = .
The tool saves the messages in a MATLAB file in your current working folder

by default. You can change the location by browsing to a different folder in
the Save dialog box.

Each time you save the message log to a file, the CAN Tool saves them as VNT

CAN Log.mat with sequential numbering by default. You can change the
name by typing a new name in Save dialog box.
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* “Overview” on page 4-2
¢ “CAN Communication in Simulink” on page 4-3
® “Opening the Vehicle Network Toolbox Block Library” on page 4-7

¢ “Building Simulink Models to Transmit and Receive Messages” on page 4-9
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Overview

This chapter describes how to use the Vehicle Network Toolbox block library.
The library contains these blocks:

® CAN Configuration — Configure the settings of a CAN device.

® CAN Pack — Pack signals into a CAN message.

® CAN Receive — Receive CAN messages from a CAN bus.

® CAN Transmit — Transmit CAN messages to a CAN bus.

CAN Unpack — Unpack signals from a CAN message.

The Vehicle Network Toolbox block library is a tool for simulating message

traffic on a CAN network, as well for using the CAN bus to send and receive
messages. You can use blocks from the block library with blocks from other
Simulink libraries to create sophisticated models.

To use the Vehicle Network Toolbox block library, you require Simulink,

a tool for simulating dynamic systems. Simulink is a model definition
environment. Use Simulink blocks to create a block diagram that represents
the computations of your system or application. Simulink is also a model
simulation environment. Run the block diagram to see how your system
behaves. If you are new to Simulink, read the Simulink Getting Started Guide
in the Simulink documentation to understand its functionality better.

For more detailed information about the blocks in the Vehicle Network
Toolbox block library, see Block Reference.
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CAN Communication in Simulink

In this section...

“Message Transmission Workflow” on page 4-4

“Message Reception Workflow” on page 4-5
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Message Transmission Workflow

Add CAN Configure the channel to
transmit messages from your

Configuration block| . o0jication

A4

Add CAN Pack Pack the data
blocks

coming from your
source application

More than one Pack
block?

Refer to "Using Mux
Add Mux blocks |Blocks" section for
more information

h 4

.| Add CAN Transmit
blocks

Transmission
model complete

This workflow represents the most common CAN Transmit model. Adjust
your model as needed. For more workflow examples, see “Building Simulink
Models to Transmit and Receive Messages” on page 4-9 and the Vehicle
Network Toolbox demos.
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Using Mux Blocks

e Use a Mux block to combine every message from the source if they are
transmitted at the same rate.

¢ Use one CAN Transmit block for each configured Mux block.

Message Reception Workflow

Add CAN Configure the channel to
Configuration block, receive messages

h

Add one CAN Set :’nessage I?Iters
Receive block o pass only
relevant messages

h

Invoke a function-call triggered
Add Function-Call | subsystem to execute when the
Subsystem block CAMN Receive block receives a

Refer to new message at a given timestep

"Downstream Processing”
section for more information.

k4

Add the CAN Unpack block inside
Add downstream Add CAN Unpack | e oo can subsystem
process blocks block

Receive model
complete

For workflow examples, see “Building Simulink Models to Transmit and
Receive Messages” on page 4-9 and the Vehicle Network Toolbox demos.

Message Filtering
Set up filters to process only relevant messages. This ensures optimal
simulation performance.

Do not set up filters if you need to parse all bus communications.
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Function-Call Triggered Message Processing
Set up your CAN Unpack block:

¢ In a function-call triggered subsystem if you want to unpack every message
received by your CAN Receive block.

® Without a function-call triggered subsystem if you want to unpack only the
most recent message received by your CAN Receive block.
Set up this system if your receive block is filtering for a single message.

Downstream Processing
For any downstream processing using received messages, include blocks:

e Within the function-call subsystem if your downstream process must
respond to all messages received in a single timestep in this model.

® Qutside the function-call subsystem if your downstream process responds
only to the most recent message received in a given timestep in this model.
In this case, the CAN Unpack block will not respond to any other messages
received, irrespective of the messages ID.
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Opening the Vehicle Network Toolbox Block Library

In this section...

“Using the MATLAB Command Window” on page 4-7
“Using the Simulink Library Browser” on page 4-7

Using the MATLAB Command Window

To open the Vehicle Network Toolbox block library, enter canlib in the
MATLAB Command Window.

MATLAB displays the contents of the library in a separate window.

] Library:canlib

File Edit View Format Help

=10l x|

DsHE| s+ B2R|(es 4|0 2naE

CAN Communication

CAN

Configuration

CAM Msg Messags Dats

CAN

Unpadk

CAN Configuration

CAMN Unpadk

CAN

Recaive

)

CAN Msg

Data

CAN
Massage CAN Msg
Padk

CAN Receive

CAN

EAN =g Transmit

CAN Transmit

Ready

CAN Padk

[100%

|Locked 4

Using the Simulink Library Browser

To open the Vehicle Network Toolbox block library, start the Simulink Library
Browser from MATLAB. Then select the library from the list of available
block libraries displayed in the browser.
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To start the Simulink Library Browser, enter simulink in the MATLAB
Command Window.

The left pane lists available block libraries, with the basic Simulink library
listed first, followed by other libraries listed alphabetically under it. To open
the Vehicle Network Toolbox block library, click its icon and select CAN
Communication for the CAN blocks.

E Simulink Library Browser EI@

File Edit View Help
0O = s - Enter search term - ﬁ

Libraries Library: Vehicle Network Toolbox/CAN Communication Search Resul 1/|»

- B Instrument Control Toolbox T
ﬂ Model Predictive Control Toolbox
- W8 Neural Network Toolbox
-1 OPC Toolbox
ﬂ Physical Modeling Development
W Real-Time Windows Target
-1 Report Generator
- %8| Robust Control Toolbox
- SimEvents
B SimPowerSystems
- SimRF
- W8 Simscape
W/ Simulink 3D Animation
-8 Simulink Coder
-8 Simulink Control Design
W Simulink Design Optimization
- Simulink Design Verifier
- W8 Simulink Extras
- Wl Simulink Verification and Validation
- Stateflow
ﬂ System Identification Toolbox
=- W Vehicle Network Toolbox

+--ﬂ xPC Target -
Showing: Vehicle Metwork Toolbox/CAN Communication

CAN Configuration

CAN Pack

CAN Receive

CAN Transmit

CAN Unpack

m

Simulink loads and displays the blocks in the library.
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Building Simulink Models to Transmit and Receive

Messages

In this section...

“Build a Message Transmit Model” on page 4-9
“Build a Message Receive Model” on page 4-15

“Save and Run the Model” on page 4-23

Build a Message Transmit Model
This section provides an example that builds a simple model using Vehicle

Network Toolbox blocks with other blocks in the Simulink library. This
example 1llustrates how to send data via a CAN network.

e Use virtual CAN channels to transmit messages.

e Use the CAN Configuration block to configure your CAN channels.

¢ Use the Constant block to send data to the CAN Pack block.

® Use the CAN Transmit block to send the data to the virtual CAN channel.
Use this section with “Build a Message Receive Model” on page 4-15 and
“Save and Run the Model” on page 4-23 to build your complete model and
run the simulation.

® “Step 1: Open the Block Library” on page 4-9

e “Step 2: Create a New Model” on page 4-10

e “Step 3: Drag Vehicle Network Toolbox Blocks into the Model” on page 4-11
e “Step 4: Drag Other Blocks to Complete the Model” on page 4-12

e “Step 5: Connect the Blocks” on page 4-13

e “Step 6: Specify the Block Parameter Values” on page 4-13

Step 1: Open the Block Library

To open the Vehicle Network Toolbox block library, start the Simulink Library
Browser by entering:
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simulink

in the MATLAB Command Window. The left pane in the Simulink Library
Browser lists the available block libraries. To open the Vehicle Network
Toolbox block library, click its icon. Then click CAN Communication to
open the CAN blocks. See Using the Simulink Library Browser for more
information.

Step 2: Create a New Model

To use a block, add it to an existing model or create a model.

For this example, create a model by clicking the New model button on the
toolbar.
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E Sirmulink Library Browser
File Edit Wiew Help

= » . Enter search term
Lihrai

-hE

=&

E Instrument Control Toolbox
E Madel Predictive Control Toolbox
+--E Meural Metwork Toolbox

-1 OPC Toolbox

+--E Physical Modeling Development
- Real-Time Windows Target
E Report Generator

E Robust Control Toolbox

+E SimEvents

+E SimPowerSystems

i SimRF

+E Simscape

4+ Simulink 3D Animation

4+ Simulink Coder

+E Simulink Control Design

+E Simulink Design Optimization
+E Simulink Design Verifier

+E Simulink Extras

E Simulink Verification and Validation

E System |dentification Toolbox
=- W Vehicle Network Toolbox

+E ¥PC Target

m

-

Library: Vehicle Network Toolbox/CAN Communication Search R

P CAM Configuration

e vemmcsst CAN Pack

CAN Receive

CAN Transmit

ewsuma =b CAN Unpack

Showing: Vehicle MNetwork Toolbox/CAN Communication

You can also select File > New > Model from the Simulink Library Browser.
Simulink opens an empty model window on the display. To name the new

model, use the Save option.

Step 3: Drag Vehicle Network Toolbox Blocks into the Model

To use the blocks in a model, click a block in the library and, holding the
mouse button down, drag it into the model window. For this example, you
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need one instance each of the CAN Configuration, CAN Pack, and CAN
Tarnsmit blocks in your model.

W Simulink Library Browser
File Edt View Help
O @ = Enter search tem
Libvanes
W Instrument Coneral Toolbe &
W Modal Predictrve Control Toalbex
< Nowral Notwork Toolbax:
W OPC Toalbox
+ B Physical Modoling Development
¥ Real-Time Windows Target
W Repont Generatar
W Robust Control Toolbax
< B SimEvents
3 W SimPowerSystams
=+ W SimRF
3 Wi Simseape
=R Simulink 30 Animation
3 i Simulink Coder
+ W Simulink Contral Design
3l Simulink Design Optimezation E
+ W Simulink Design Viorier
3 Wi Simulink Extras
W Simulink Verification and Validation
W Statefow
W System Identification Toolb
¥ Vehicle Netwark Tooibax
CAN Communication

3 [ %PC Target -

-nm

Showing: Vehicle Network Toolbax/CAN Communication

(E==on ===

Library: Vehicke Network Toolbox/CAN Communication | Search Rasul 1 [#]

CAN Configuration —

W can Cemmunication
File B

0 &FdS B

ERENE

b wfor e Sl BB

CAN Pack ~_

CAN Receive e

CAN Trangmit____ —

CAN Unpack e

AN Conlgueation

e

Vogaos AL corsng

astsr Vinual 1
Chasnal 1

caN g

Step 4: Drag Other Blocks to Complete the Model

This example requires a source block that feeds data to the CAN Pack block.
Add a Constant block to your model.
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W Simulind k Libirary Browser = (EE W CAN Communication [o e
File  Edit  View Semulshion Feemat  Took  Help
O @ » Eterseachiem - My & D edS Pl x| b om0 [Homd - B R
Libvaries Library: SimulinkiSources | Search Results: (none) | Most Fraquent 1 [»
W Simulink -
Cammanl by Used Blocks Band-Limited White Naise
Contnuous
Discontinuities
Discrete -'"M}» Chirp Signal
Legic and Bit Operations .
Loakup Tables = g AN wag e
Math parations ( L) Clock L
Modsl Vertication = T
Model Wide Untilities
Ports & Subsystems }’ Conglant
Signal Adtributes
Signal fouting
Sinks AFE Couner Fren-Running
Sources
UserDefined Functicns o
© Addiionsl Math & Discrete L
4 W Aeraspace Blockss
+ il Communications
& p Digital Clock
[rrermr}  Enumersted Comstant
W Data Acquisition Toolbax e}
< W EDA Simulator Link 2
Showing: Simulink/Sources Ready 0% cdels

Step 5: Connect the Blocks

Make a connection between the Constant block and the CAN Pack block.
When you move the pointer near the output port of the Constant block, the
pointer becomes a cross hair. Click the Constant block output port and,
holding the mouse button, drag the pointer to the input port of the CAN Pack
block. Then release the button.

In the same way, make a connection between the output port of the CAN Pack
block and the input port of the CAN Transmit block.

The CAN Configuration block does not connect to any other block. This block

configures the CAN channel used by the CAN Transmit block to transmit
the packed message.

Step 6: Specify the Block Parameter Values
You set parameters for the blocks in your model by double-clicking the block.

Configure the CAN Configuration Block. Double-click the CAN
Configuration block to open its parameters dialog box. Set the:

®¢ Device to Vector Virtual 1 (Channel 1)
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* Bus speed to 500000
e Acknowledge Mode to Normal

Click OK.

Configure the CAN Pack Block. Double-click the CAN Pack block to open
its parameters dialog box. Set the:

® Data is input as to raw data

® Name to the default value CAN Msg

¢ Identifier type to the default Standard (11-bit identifier) type

¢ Identifier to 500

Length (bytes) to the default length of 8

Click OK.

Configure the CAN Transmit Block. Double-click the CAN Transmit
block to open its parameters dialog box. Set Device to Vector Virtual 1

(Channel 1). Click Apply, then OK.

Configure the Constant Block. Double-click the Constant block to open its
parameters dialog box. On the Main tab, set the:

®* Constant valueto[1 2 3 4 5 6 7 8]

e Sample time to 0.01 seconds
On the Signal Attributes tab, set the Output data type to uint8. Click OK.

Your model looks like this figure.
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§_| CAM_Communication EI@
File Edit View Simulation Format Tools Help
O =E&E ) » 100 [Nomal ] & =1
Vector Virtual 1
Channel 1
Bus speed: 500000
CAN Configuration
=~ = Message: CAN Msg Vector Virtual 1
58 P CAl P Py
12248878 L Standard ID: 0 N Mg B CANME  annel 1
Constant
CAN Padk CAN Transmit
Ready 100% oded5

Build a Message Receive Model

This section provides an example that builds a simple model using the Vehicle
Network Toolbox blocks with other blocks in the Simulink library. This
example illustrates how to receive data via a CAN network.

e Use a virtual CAN channel to receive messages.

e Use the CAN Configuration block to configure your virtual CAN channels.
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e Use the CAN Receive block to receive the message sent by the blocks built
in “Build a Message Transmit Model” on page 4-9.

¢ Use a Function—Call Subsystem block that contains the CAN Unpack
block. This function takes the data from the CAN Receive block and uses
the parameters of the CAN Unpack block to unpack your message data.

e Use a Scope block to show the transfer of data visually.

Use this section with “Build a Message Transmit Model” on page 4-9 and
“Save and Run the Model” on page 4-23 to build your complete model and
run the simulation.

e “Step 7: Drag Vehicle Network Toolbox Blocks into the Model” on page 4-16
e “Step 8: Drag Other Blocks to Complete the Model” on page 4-17

e “Step 9: Connect the Blocks” on page 4-20

e “Step 10: Specify the Block Parameter Values” on page 4-21

Step 7: Drag Vehicle Network Toolbox Blocks into the Model
For this example, you need one instance each of the CAN Configuration, CAN
Receive, and CAN Unpack blocks in your model. However, you add only the
CAN Configuration and the CAN Receive blocks here. Add the CAN Unpack
block into the Function—Call Subsystem described in “Step 8: Drag Other
Blocks to Complete the Model” on page 4-17.

Tip Configure a separate CAN channel for the CAN Receive and CAN
Transmit blocks.
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Step 8: Drag Other Blocks to Complete the Model
Use the Function—Call Subsystem block from the Simulink Ports &
Subsystems block library to build your CAN Message pack subsystem.

1 Drag the Function—Call Subsystem block into the model.

W Simulink Library Browser
O @ = Enter search tem
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| = W Simulink
Commanly Used Blocks
-Contnuous
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“Lookup Tables
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User-Defined Functions
+ Additional Math & Discrete
=W Aerospace Blocksat
3 i Communications System Toalbox
=B Computer Vision System Toolbax
W Control System Toalbox
=W DSP Systorn Toolbex
¥ Data Acquisition Toolbax
< W EDWA Simulator Link

 Shoing: Simuink/Ports & Subsystems

-
Library: SimulinkPoets & Subsystems | Search Rasults: (nons) ] mt:
For e Subaystom

=

(o}
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w "%\ﬂ
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DEdS BlEs 4|2 b o0 [Hmd =] B e
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e
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2 Double-click the Function—Call Subsystem block to open the subsystem

model.
E CAN_Communication/Function-Call Subsystem EI@
File Edit View Simulation Format Tools Help
O =E& T [ 2 10.0 Nomal
function
- »_1)
In1 Outl
Ready 100% oded5

3 Drop the CAN Unpack block from the Vehicle Network Toolbox block
library in this subsystem.
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To see the results of the simulation visually, drag the Scope block from the
Simulink block library into your model.
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Step 9: Connect the Blocks
1 Connect the CAN Msg output port on the CAN Receive block to the Inl
input port on the Function—Call Subsystem block.

Wector Virtual 1 fi)
Channel 1
Std. D= all —_— function)
Ext. IDs: al@ el i Suth
R ——
CAN Receive Function-Call
Subsystam

2 Open the Function—Call Subsystem block and:
® Double-click Inl to rename it to CAN Msg.
¢ Double-click Outl to rename it to data.
3 Rename the Function—Call Subsystem block to CAN Unpack Subsystem.

4 Connect the f() output port on the CAN Receive block to the function()
input port on the Function—Call Subsystem block.

Vector Virtual 1 i
Channel 1

Std. IDs: all
Ext. IDs: all CAN Msg

CAN Receive CAN Unpadk
Subsystem

5 Connect the CAN Unpack Subsystem output port to the input port on the

Scope block.

Your model looks like this figure.
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The CAN Configuration block does not connect to any other block. This

block configures the CAN channel used by the CAN Receive block to receive

the CAN message.

Step 10: Specify the Block Parameter Values
Set parameters for the blocks in your model by double-clicking the block.

Configure the CAN Configuration1 Block. Double-click the CAN

Configuration block to open its parameters dialog box. Set the:
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¢ Device to Vector Virtual 1 (Channel 2)
* Bus speed to 500000
e Acknowledge Mode to Normal

Click OK.

Configure the CAN Receive Block. Double-click the CAN Receive block to
open its Parameters dialog box. Set the:

® Device to Vector Virtual 1 (Channel 2)

e Sample time to 0.01

* Number of messages received at each timestep to A1l
Click OK.

Configure the CAN Unpack Subsystem. Double-click the CAN Unpack
subsystem to open the Function—Call Subsystem model. In the model,
double-click the CAN Unpack block to open its parameters dialog box. Set the:
e Data to be output as to raw data

® Name to the default value CAN Msg

¢ Identifier type to the default Standard (11-bit identifier) type

¢ Identifier to 500

Length (bytes) to the default length of 8
Click OK.

Your subsystem looks like this figure.
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W CAN_Communication/CAN unpack Subsystem EI@
File Edit View Simulation Format Tools Help
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Save and Run the Model

This section shows you how to save the models you built, “Build a Message
Transmit Model” on page 4-9 and “Build a Message Receive Model” on page
4-15.

e “Step 11: Save the Model” on page 4-23

e “Step 12: Change Configuration Parameters” on page 4-24

e “Step 13: Run the Simulation” on page 4-24

e “Step 14: View the Results” on page 4-25

Step 11: Save the Model

Before you run the simulation, save your model by clicking the Save icon or
selecting File > Save from the menu bar.

4-23



4 Communications in Simulink

4-24

Step 12: Change Configuration Parameters

1 In your model window, select Simulation > Configuration Parameters.
The Configuration Parameters dialog box opens.

2 In the Solver Options section, select:
¢ Fixed-step from the Type list.

¢ Discrete (no continuous states) from the Solver list.

Step 13: Run the Simulation

To run the simulation, click the Start button on the model window toolbar.
Alternatively, you can use the Simulation menu in the model window and
choose the Start option.

When you run the simulation, the CAN Transmit block gets the message from
the CAN Pack block. It then transmits it via Virtual Channel 1. The CAN
Receive block on Virtual Channel 2 receives this message and hands it to the
CAN Unpack block to unpack the message.

While the simulation is running, the status bar at the bottom of the model
window updates the progress of the simulation.
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Compiling : Propagating conditional contexts

Step 14: View the Results
Double-click the Scope block to view the message transfer on a graph.
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n Scope |E|

SBE|FPLPPL AHARRE TA

Alg)
"]

If you cannot see all the data on the graph, click the Autoscale toolbar button,
which automatically scales both axes to display all stored simulation data.

uScope EIIEI
GH|LOL L ﬁ% BaF -

Autoscale

In the graph, the horizontal axis represents the simulation time in seconds
and the vertical axis represents the received data value. In the Message
Transmit model, you configured blocks to pack and transmit an array of
constant values, [1 23 45 6 7 8], every 0.01 second of simulation time. In the
Message Receive model, these values are received and unpacked. The output
in the Scope window represents the received data values.



Function Reference

CAN Channel Construction (p. 5-2)

CAN Channel Configuration (p. 5-3)

CAN Channel Execution (p. 5-4)

CAN Channel Status (p. 5-5)

CAN Database (p. 5-6)
CAN Message Handling (p. 5-7)

CAN Message Filtering (p. 5-8)

Information and Help (p. 5-9)

Graphical Tools (p. 5-10)
Vector Informatik (p. 5-11)

Functions related to constructing
CAN channel

Functions related to configuring
CAN channel

Functions related to executing
configured CAN channel.

Functions related to checking and
modifying CAN channel status

Functions related to CAN database

Functions related to working with
CAN messages

Functions related to setting up CAN
message filters

Functions related to displaying help
information

Functions related to CAN Tools

Functions specifically related to
Vector hardware functionality
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CAN Channel Construction

canChannel Construct CAN channel connected
to selected device
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CAN Channel Configuration

CAN Channel Configuration

get Return property values

set Configure property values
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CAN Channel Execution

transmitPeriodic

receive
replay
start
stop
transmit

transmitConfiguration

transmitEvent

Configure a message for periodic
transmit

Receive messages from CAN bus
Retransmit messages from CAN bus
Set CAN channel online

Set CAN channel offline

Send CAN messages to CAN bus

Display messages configured for
automatic transmit

Configure a message for event-based
transmit



CAN Channel Status

CAN Channel Status

configBusSpeed Set bit timing rate of CAN channel
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CAN Database

canDatabase
messageInfo

signallnfo

Create handle to CAN database file
Information about CAN messages

Information about signals in CAN
message



CAN Message Handling

CAN Message Handling

attachDatabase

canMessage
canMessagelImport
extractAll
extractRecent
extractTime

pack

unpack

Attach CAN database to messages
and remove CAN database from
messages

Build CAN message based on
user-specified structure

Import CAN message log file from a
third-party vendor tool

Select all instances of message from
array of messages

Select most recent message from
array of messages

Select messages occurring within
specified time range from array of
messages

Pack signal data into CAN message

Unpack signal data from message
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CAN Message Filtering

filterReset Open CAN message acceptance
filters
filterSet Set specific CAN message acceptance

filter configuration



Information and Help

Information and Help

canHWInfo Information on available CAN
devices
canSupport Generate technical support log
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Graphical Tools

canTool Open CAN Tool
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Vector Informatik

Vector Informatik

filterAcceptRange

filterBlockRange

Set range of CAN identifiers to pass
acceptance filter

Set range of CAN identifiers to block
via acceptance filter
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attachDatabase

6-2

Purpose

Syntax

Arguments

Description

Tips

Examples

See Also

Attach CAN database to messages and remove CAN database from
messages

attachDatabase (message, database)
attachDatabase (message, [])

message The name of the CAN message that you
want to attach the database to or remove
the database from.

database The name of the database (.dbc file) that
you want to attach to the message or
remove from the message.

attachDatabase (message, database) attaches the specified
database to the specified message. You can then use signal-based
interaction with the message data, interpreting the message in its
physical form.

attachDatabase (message, []) removes any attached database from
the specified message. You can then interpret messages in their raw
form.

If the specified message is an array, then the database attaches itself
to each entry in the array. The database attaches itself to the message
even if the message you specified does not exist in the database. The
message then appears and operates like a raw message. To attach the
database to the CAN channel directly, edit the Database property of
the channel object.

candb = canDatabase('C:\Database.dbc')
message = receive(canch, Inf)
attachDatabase(message, candb)

canDatabase | receive



canChannel

Purpose

Syntax

Arguments

Description

Tips

Construct CAN channel connected to selected device

canch = canChannel('vendor', 'device', devicechannelindex)
canch = canChannel('vendor', 'devicenumber')
vendor The name of the CAN device vendor. Specify
the vendor name as a string.
device The CAN interface that you want to connect
to.

devicechannelindex A numeric channel on the specified device.

canch The CAN channel object the you create.

canch = canChannel('vendor', 'device', devicechannelindex)
returns a CAN channel connected to a device from a specified vendor.

For Vector products, device is a combination of the device type and a
device index, such as 'CANCaseXL 1'. For example, if there are two
CANcardXL devices, device can be 'CANcardXL 1' or 'CANcardXL 2'.

For National Instruments CAN devices, use canch =
canChannel('vendor', 'devicenumber'), where the vendor is the
literal string 'NI', and the devicenumber is the interface number
defined for the channel in NI Measurement & Automation Explorer.

® You cannot have more than one active connection to the same NI
device channel.

e Use canHWInfo to obtain a list of available devices.
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Examples

See Also

canch canChannel('Vector', 'CANCaseXL 1',1)
canch = canChannel('Vector', 'Virtual 1',2)
canch canChannel('NI', 'CAN1')

Notes You cannot use the same variable to create multiple channels
sequentially. Clear any channel in use before using the same variable
to construct a new CAN channel.

You cannot create arrays of CAN channel objects. Each object you
create must exist as its own individual variable.

canHWInfo
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Purpose
Syntax

Description

Examples

See Also

Create handle to CAN database file
candb = canDatabase('dbfile.dbc')

candb = canDatabase('dbfile.dbc') creates a handle to the specified
database file dbfile.dbc. You can specify just a file name, a full path,
or a relative path. MATLAB looks for dbfile.dbc on the MATLAB
path. Vehicle Network Toolbox supports the Vector CAN database
(.dbc) files.

candb = canDatabase('C:\Database.dbc')

canMessage
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Purpose
Syntax

Description

Examples

See Also

Information on available CAN devices

out canHWInfo()

out canHWInfo() returns information about CAN devices and
displays the information on a per vendor and channel basis. Use get on
the output of canHWInfo to obtain more detailed results.

info = canHWInfo;
get(info)
ToolboxName: 'Vehicle Network Toolbox'
ToolboxVersion: '1.3 (R2010b)'
MATLABVersion: '7.11 (R2010b)'
VendorInfo: [1x2 can.VendorInfo]

canChannel
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Purpose

Syntax

Arguments

Description

Examples

Build CAN message based on user-specified structure

message = canMessage(id, extended, datalength)
message = canMessage(database, messagename)

id The ID of the message that you specify.

extended Indicates whether the message ID is of standard or
extended type. The Boolean value is true if extended
or false if standard.

datalength The length of the data of the message, in bytes.
Specify from 0 through 8.

database Handle to the CAN database containing the message
definition.

messagename  The name of the message definition in the database.

message The message object returned from the function.

message = canMessage(id, extended, datalength) creates and
returns a CAN message object, from the raw message information.

message = canMessage(database, messagename) constructs a
message using the message definition of the specified message, in the
specified database.

To construct a CAN message, type:
message = canMessage (2500, true, 4)

To construct a message using CAN database message definitions, create
a database object using the canDatabase function, and then construct
your message:

candb = ('c:\database.dbc')
message = canMessage (candb, 'messagename’)



canMessage

See Also attachDatabase | canDatabase | extractAll | extractRecent |
extractTime | pack | unpack
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Purpose

Syntax

Arguments

Description

Tips

Import CAN message log file from a third-party vendor tool

message = canMessageImport('file', 'vendor')
message = canMessagelImport('file', 'vendor', database)
file Name of the CAN message log file to import.
vendor Name of the vendor whose CAN message log file
to import.
database Name of the database whose information to attach
to the imported log file.
message The message object returned by the function.
message = canMessageImport('file', 'vendor') allows you to

import a CAN message log file, file, from a third-party vendor, vendor,
into Vehicle Network Toolbox. All the messages in the log file are
imported as CAN messages, compatible with MATLAB and displayed

as an array.

message = canMessageImport('file', 'vendor', database) allows
you to apply a specify a database handle, database. The information in
the specified database is applied to the imported CAN log messages.

Once imported, you can analyze, transmit, or replay these messages.

® You can import message logs only in certain file formats. You can
import only ASCII files from Vector and text files from Kvaser.

® canMessageImport assumes that the information in the imported log
file is in a hexadecimal format.

® canMessageImport assumes that the timestamps in the imported log
file are absolute values.

¢ To import Vector log files with symbolic message names, specify an
appropriate database file in the input arguments.
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Examples To import a log file, type:

message = canMessageImport('MsgLog.asc', 'Vector')

To specify a database name, type:

database = canDatabase('myDatabase.dbc')

message = canMessageImport('MsgLog.txt', 'Kvaser', database)

See Also canDatabase | receive | transmit
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Purpose Generate technical support log
Syntax canSupport()
Descripl‘ion canSupport () returns diagnostic information for all installed CAN

devices and saves output to the text file cansupport.txt in the current
working directory.

For online support of Vehicle Network Toolbox software, visit the
toolbox page on the MathWorks Web site.

6-11
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canTool

Purpose Open CAN Tool
Syntax canTool
Description canTool starts the CAN Tool, which displays live CAN message traffic.

Use the CAN Tool to view message traffic using a selected CAN device
and channel. You can also save messages to a log file via this tool.

For more information about this tool, refer to Chapter 3, “Monitoring
CAN Message Traffic”.
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Purpose

Syntax

Arguments

Description

Tips

Set bit timing rate of CAN channel

configBusSpeed(canch, busspeed)
configBusSpeed(canch, busspeed, sjw, tsegl, tseg2,

numberofsamples)
canch The CAN channel object that you want to set the
bit timing rate for.
busspeed The user-specified bit timing rate for the specified
object.
sjw The synchronization jump width. This value is the

maximum value of time bit adjustments.

tseg1 The length of time at the start of the sample point
within a bit time.

tseg2 The length of time at the end of the sample point
within a bit time.

numberofsamples The specified count of bit samples used.

configBusSpeed(canch, busspeed) sets the speed of the CAN channel
in a direct form that uses baseline bit timing calculation factors.

configBusSpeed(canch, busspeed, sjw, tsegl, tseg2,
numberofsamples) sets the speed of the CAN channel canch to
busspeed using the specified bit timing calculation factors to control
the timing in an advanced form.

Unless you have specific timing requirements for your CAN connection,
use the direct form of configBusSpeed. Also note that you can set the
bus speed only when the CAN channel is offline. The channel must also
have initialization access to the CAN device.

Synchronize all nodes on the network for CAN to work successfully.
However, over time, clocks on different nodes will get out of sync, and
must resynchronize. SJW specifies the maximum width (in time) that
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Examples

See Also

you can add to tseg1 (in a slower transmitter), or subtract from tseg2
(in a faster transmitter) to regain synchronization during the receipt
of a CAN message.

To configure the bus speed using baseline bit timing calculation, type:

canch = canChannel('Vector', 'CANCaseXL 1',1)
configBusSpeed(canch,250000)

To specify the bit timing calculations, type:

canch = canChannel('Kvaser', 'USBcan Professional 1', 1)
configBusSpeed(channel, 500000, 1, 4, 3, 1)

canChannel



extractAll

Purpose

Syntax

Arguments

Description

Tips

Select all instances of message from array of messages

[extracted, remainder] = extractAll(message, messagename)
[extracted, remainder] extractAll (message, id, extended)

message An array of CAN message objects that you specify
to parse and find the specified messages by name
or ID.

messagename The name of the message that you specify to
extract.

id The ID of the message that you specify to extract.

extended Indicates whether the message ID is a standard

or extended type. The Boolean value is true if
extended and false if standard.

extracted An array of CAN message objects returned with
all instances of id found in the message.

remainder A CAN message object containing all messages in
the original input message with all instances of
id removed.

[extracted, remainder] = extractAll(message, messagename)
parses the given array message, and returns all instances of messages
matching the specified message name.

[extracted, remainder] = extractAll(message, id, extended)
parses the given array message, and returns all instances of messages
matching the specified ID with the specified standard or extended type.

You can specify id as a cell array of message names or a vector of
identifiers. For example, if you pass id in as [250 5000], [false true],
extractAll returns every instance of both CAN message 250 and
message 5000 that it finds in the message array. If any id in the vector
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1s an extended type, set extended to true and as a vector of the same
length as id.

Examples [msgOut, remainder]=extractAll(message, 'msg1')
[msgOut, remander]=extractAll(message,{'msgl' 'msg2' 'msg3'})
[msgOut, remainder]=extractAll(message, 3000, true)

[msgOut, remainder]=extractAll(message,[200 5000],[false true])

See AISO extractRecent | extractTime
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Purpose

Syntax

Arguments

Description

Tips

Select most recent message from array of messages

extracted = extractRecent(message)
extracted = extractRecent(message, messagename)
extracted = extractRecent(message, id, extended)

message An array of CAN message objects that you specify to
parse and find the specified messages by name or ID.

messagename The name of the message that you specify to extract.
id The id of the message that you specify to extract.

extended Indicates whether the message ID is a standard
or extended type. The Boolean value is true if
extended and false if standard.

extracted An array of CAN message objects returned with the
most recent instance of id found in the message.

extracted = extractRecent(message) parses the given array
message and returns the most recent instance of each unique CAN
message found in the array.

extracted = extractRecent(message, messagename) parses the
specified array of messages and returns the most recent instance
matching the specified message name.

extracted = extractRecent(message, id, extended) parses the
given array message and returns the most recent instance of the
message matching the specified ID with the specified standard or
extended type.

You can specify id as a vector of identifiers. For example, if you pass
id in as [250 500], extractRecent returns the latest instance of both
CAN message 250 and message 500 if it finds them in the message
array. By default, all identifiers in the vector are standard CAN
message identifiers unless extended is true. If any id in the vector is
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an extended type, then extended i1s true and is a vector of the same
length as id.

Examples msgOut = extractRecent(message)
msgOut = extractRecent(message, 'msgl')
msgOut = extractRecent(message, {'msgl' 'msg2' msg3'})
msgOut = extractRecent(message, 3000, true)

msgOut = extractRecent(message, [400, 5000], [false true])

See Also extractAll | extractTime
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Purpose

Syntax

Arguments

Description

Tips

Examples

See Also

Select messages occurring within specified time range from array of
messages

extracted = extractTime(message, starttime, endtime,

msgRange)

message An array of CAN message objects.

starttime The beginning of the time range in seconds that
you specify. Returns messages with a timestamp
greater than or equal to the specified start time.

endtime The end of the time range in seconds that you
specify. Parses messages with a timestamp up
to the specified end time, including the specified
end time.

extracted An array of CAN message objects returned with

all messages that occur within and including
starttime and endtime.

extracted = extractTime(message, starttime, endtime,
msgRange) parses the array message and returns all messages with a
timestamp within the specified starttime and endtime, including the
starttime and endtime

Specify the time range in increasing order from starttime to endtime.
If you must specify the largest available time, endtime also accepts
Inf as a valid value. The earliest acceptable time you can specify for
starttime is 0.

msgRange = extractTime(message, 5, 10.5)
msgRange extractTime (message, 0, 60)
msgRange = extractTime(message, 150, Inf)

extractAll | extractRecent
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Purpose Set range of CAN 1identifiers to pass acceptance filter

Syntax filterAcceptRange(canch, rangestart, rangeend)

Note You cannot set filters on an NI device channel.

Arguments canch The CAN channel that you want to set the filter for.

rangestart  The first identifier of the range of message IDs that
the filter accepts.

rangeend The last identifier of the range of message IDs that
the filter accepts.

Description filterAcceptRange(canch, rangestart, rangeend) sets the
acceptance filter for standard identifier CAN messages. It allows
messages within the given range on the CAN channel canch to pass.
rangestart and rangeend establish the beginning and end of the
acceptable range. You can use this function with Vector devices only.



filterAcceptRange

Tips

Examples

See Also

Notes

® You can configure message filtering only when the CAN channel is
offline.

® CAN message filters initialize to fully open.

e filterReset makes the acceptance filters fully open.

e filterAcceptRange supports only standard (11-bit) CAN identifiers.

®* You must set the values from rangestart through rangeend in
increasing order.

e filterAcceptRange and filterBlockRange work together by
allowing and blocking ranges of CAN messages within a single filter.
You can perform both operations multiple times in sequence to
custom configure the filter as desired.

When you call filterAcceptRange on an open or reset filter, it
automatically blocks the entire standard CAN identifier range, allowing
only the desired range to pass. Subsequent calls to filterAcceptRange
open additional ranges on the filter without blocking the ranges
previously allowed.

canch = canChannel('Vector', 'CANCaseXL 1',1)
filterAcceptRange(canch,600,625)
filterAcceptRange(canch,705,710)

filterBlockRange | filterReset | filterSet
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Purpose

Syntax

Arguments

Description

Tips

Set range of CAN identifiers to block via acceptance filter

filterBlockRange(canch, rangestart, rangeend)

Note You cannot set filters on an NI device channel.

canch The CAN channel that you want to set the filter for.

rangestart  The first identifier of the range of message IDs that
the filter starts blocking at.

rangeend The last identifier of the range of message IDs that
the filter stops blocking at.

filterBlockRange(canch, rangestart, rangeend) blocks messages
within a given range by setting an acceptance filter. You can use this
function with Vector devices only.

® You can configure message filtering only when the CAN channel is
offline.

¢ CAN message filters initialize to fully open.
e filterReset makes the acceptance filters fully open.
e filterBlockRange supports only standard (11-bit) CAN identifiers.

® You must set the values from rangestart through rangeend in
increasing order.

e filterBlockRange and filterAcceptRange work together by
blocking and allowing ranges of CAN messages within a single filter.
You can perform both operations multiple times in sequence to
custom configure the filter as desired.
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Examples You can set the filter to block or accept messages within a specific range.

canch = canChannel('Vector', 'CANCaseXL 1',1)
filterBlockRange(canch, 500, 750)
filterAcceptRange(canch,600,625)
filterAcceptRange(canch,705,710)
filterBlockRange(canch,1075,1080)

See Also filterAcceptRange | filterReset | filterSet
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Purpose

Syntax

Description

Examples

See Also

6-24

Open CAN message acceptance filters

filterReset(canch)

Note You cannot set filters on an NI device channel.

filterReset(canch) resets the CAN message filters on the CAN
channel canch for both standard and extended CAN identifier types.
Then all messages of all identifier types can pass.

This function does not work if the channel is online. Make sure that the
channel is offline before calling filterReset.

Reset the message filters as shown:

canch = canChannel('Vector', 'CANCaseXL 1',1)
filterBlockRange(canch, 500, 750)
filterAcceptRange(canch,600,625)
filterAcceptRange(canch,705,710)
filterBlockRange(canch,1075,1080)
filterSet(canch, 500, 750, 'Standard')
filterReset(canch)

filterAcceptRange | filterBlockRange | filterSet
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Purpose

Syntax

Arguments

Description

Tips

Set specific CAN message acceptance filter configuration

filterSet(canch, code, mask, idtype)
filterSet(canch, id, idtype)

Note You cannot set filters on an NI device channel.

canch The CAN channel that you want to set the filter for.

code The value required for each bit position of the
identifier.

mask The bits in the identifier that are relevant to the filter.

id Set a filter on the CAN message with the id, range of

ids, multiple ranges of ids, or a combination of ids.

idtype A string specifying either a standard or an extended
CAN message id type.

filterSet(canch, code, mask, idtype) sets the CAN message
acceptance filter to the specified code and mask. You also must specify
the CAN identifier type idtype on the CAN channel canch.

filterSet(canch, id, idtype) sets the CAN message acceptance
filter by determining the best possible code and mask based on the ID
and identifier type specified in the input argument.

® You can configure message filtering only when the CAN channel is
offline.

® CAN message filters initialize to fully open.

e Use filterReset to make the acceptance filters fully open.

e filterSet supports either standard or extended CAN identifiers.
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Examples canch = canChannel('Vector', 'CANCaseXL 1',1)
filterSet(canch,500,750, 'Standard')
filterSet(canch,2500,3000, 'Extended"')

To let Vehicle Network Toolbox determine the best possible code and
mask option:

canch = canChannel('Kvaser', 'USBcan Professional 1', 1)
filterSet(canch, [500:502 1000], 'Standard')
filterSet(canch, [7500:8000 12000], 'Extended')

See Also filterAcceptRange | filterBlockRange | filterReset
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Purpose
Syntax

Description

Examples

Return property values

out get (obj)

out = get (obj) returns the structure out, where each field name is
the name of a property of the specified object and each field contains
the value of that property.

Configure a CAN channel:

canch = canChannel('Vector', 'CANCaseXL 1',1)

Call get on the CAN channel object to obtain the properties of the
configured CAN channel:

get (canch)

Configure a CAN message:

message = canMessage (250, true, 8)

Call get on the message object to obtain the properties of the configured
message:

get (message)
Configure a CAN database:

candb = canDatabase('C:\Database.dbc')

call get on the database to obtain the properties of the configured
database:

get (candb)
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Purpose Information about CAN messages

Syntax msgInfo = messagelInfo(candb)
msgInfo = messageInfo(candb, 'msgName')
msgInfo = messageInfo(candb, id, extended)

Arguments candb The database containing the CAN messages that you
want information about.
msgName The name of the message you want information about.
id The numeric identifier of the specified message.

extended Indicates whether the message ID is in standard or
extended type. The Boolean value is true if extended
and false if standard.

Description msgInfo = messageInfo(candb) returns information about CAN
messages in the specified database candb.

msgInfo = messageInfo(candb, 'msgName') returns information
about the specified message 'msgName ' in the specified database candb.

msgInfo = messageInfo(candb, id, extended) returns information
about the message with the specified standard or extended ID in the
specified database candb.

Examples candb = canDatabase('c:\Database.dbc')
msgInfo = messagelInfo(candb)
msgInfo = messagelInfo(candb, 'msgName')
msgInfo messageInfo(candb, 500, false)

See Also canDatabase | canMessage | signallnfo
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Purpose

Syntax

Arguments

Description

Examples

See Also

Pack signal data into CAN message

pack (message, value, startbit, signalsize, byteorder)

message

value

startbit

signalsize

byteorder

The CAN message structure that you specify for the
signal to be packed in.

The value of the signal you specify to be packed in
the message.

The signal’s starting bit in the data. This is the least
significant bit position in the signal data. Accepted
values for startbit are from 0 through 63.

The length of the signal in bits. Accepted values for
signalsize are from 1 through 64.

The signal byte order format. Accepted values are
'LittleEndian' and 'BigEndian'.

pack(message, value, startbit, signalsize, byteorder) takes
specified input parameters and packs them into the message.

pack(message, 25, 0, 16, 'LittleEndian')

canMessage | extractAll | extractRecent | extractTime | unpack
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Purpose

Syntax

Arguments

Description

Examples

See Also

6-30

Receive messages from CAN bus

message = receive(canch, messagesrequested)

canch The CAN channel from which to receive the
message.

messagesrequested The maximum count of messages to receive.
The specified value must be a nonzero and
positive, or Inf.

message An array of CAN message objects received
from the channel.

message = receive(canch, messagesrequested) returns an array of
CAN message objects received on the CAN channel canch. The number
of messages returned is less than or equal to messagesrequested. If
fewer messages are available than messagesrequested specifies, the
function returns the currently available messages. If no messages are
available, the function returns an empty array. If messagesrequested
is infinite, the function returns all available messages.

To understand the elements of a message, refer to canMessage.
canch = canChannel('Vector', 'CANCaseXL 1',1)
start(canch)
message = receive(canch,5)

To receive all messages, type:

message = receive(canch,Inf)

canChannel | canMessage | transmit
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Purpose

Syntax

Arguments

Description

Examples

Retransmit messages from CAN bus

replay(canch, message)

canch The CAN channel that you specify to transmit
the messages.

message An array of message objects to replay.

replay(canch, message) retransmits the message or messages
message on the channel canch, based on the relative differences of their
timestamps. The replay function also replays messages from MATLAB
to Simulink

To understand the elements of a message, refer to canMessage.

This example uses a loopback connection between two channels where:

¢ The first channel transmits messages 2 seconds apart.
® The second channel receives them.

® The replay function retransmits the messages with the original
delay.

ch1 = canChannel('Vector', 'CANcaseXL 1', 1)
ch2 = canChannel('Vector', 'CANcaseXL 1', 2)
start(ch1)
start(ch2)

msgTx1 = canMessage (500, false, 8)

msgTx2 = canMessage (750, false, 8)

%The first channel transmits messages 2 seconds apart
transmit(ch1, msgTx1)

pause(2)

transmit(ch1, msgTx2)

%The second channel receives them

msgRx1 = receive(ch2, Inf)
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%The replay function retransmits the messages with the original delay.
replay(ch2, msgRx1)
pause(2)

msgRx2 = receive(ch1, Inf)

The timestamp differentials between messages in the two receive
arrays, msgRx1 and msgRx2, are equal.

See Also canChannel | canMessage | receive | transmit
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Purpose
Syntax

Description

Examples

Configure property values
set (obj, propertyname, propertyvalue)

set (obj, propertyname, propertyvalue) configures the specified
property, propertyname, on the object obj, to the value specified in
propertyvalue.

To set a CAN channel property:

canch = canChannel('Vector', 'CANcaseXL 1', 1)
set (canch, 'SilentMode', true)

To set a CAN message property:

message = canMessage (250, 8, true)
set (message, 'Remote', true)

To set a CAN message signal property:

candb = canDatabase('C:\Database.dbc')
message = canMessage(candb, 'Battery_Voltage')
set (message, 'BatVlt', 9.3)
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Purpose Information about signals in CAN message

Syntax SigInfo = signalInfo(candb, 'msgName')
SigInfo = signallInfo(candb, id, extended)
SigInfo = signallInfo(candb, id, extended, 'signalName')

Arguments candb The database containing the signals that you want
information about.
msgName The name of the message that contains the signals that
you want information about.
id The numeric identifier of the specified message that
contains the signals you want information about.
extended Indicates whether the message ID is in standard or

extended type. The Boolean value is true if extended
and false if standard.

signalName The name of the specific signal that you want
information about.

SigInfo The signal information object returned from the
function.
Description SigInfo = signalInfo(candb, 'msgName') returns information about

the signals in the specified CAN message msgName, in the specified
database candb.

SigInfo = signalInfo(candb, id, extended) returns information
about the signals in the message with the specified standard or
extended ID id, in the specified database candb.

SigInfo = signalInfo(candb, id, extended, 'signalName')
returns information about the specified signal 'signalName' in the
message with the specified standard or extended ID id, in the specified
database candb.

Examples SigInfo=signalInfo(candb, 'Battery_Voltage')
SigInfo=signalInfo(candb, 'Battery Voltage', 196608, true)
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SigInfo=signalInfo
(candb, 'Battery Voltage', 196608, true, 'BatVlt')

See Also canDatabase | canMessage | messageInfo
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Purpose
Syntax

Description

Examples

See Also

Set CAN channel online
start(canch)

start(canch) starts the CAN channel canch on the CAN bus to send
and receive messages. The CAN channel remains online unless:

® You call stop on this channel.

¢ The channel clears from the workspace.

canch = canChannel('Vector', 'CANCaseXL 1',1)
start(canch)

stop



stop

Purpose
Syntax

Description

Examples

See Also

Set CAN channel offline
stop(canch)

stop(canch) stops the CAN channel canch on the CAN bus. The CAN
channel also stops running when you clear canch from the workspace.

canch = canChannel('Vector', 'CANCaseXL 1',1)

start(canch)
stop(canch)

start
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Purpose

Syntax

Arguments

Description

Tips

Examples

Send CAN messages to CAN bus

transmit(canch, message)

canch The CAN channel that you specify to transmit the
message.
message The message or an array of messages that you specify

to transmit via a CAN channel.

transmit(canch, message) sends the array of messages onto the bus
via the CAN channel.

To understand the elements of a message, refer to canMessage.

The Transmit function ignores the Timestamp property and the Error
property.

message = canMessage (250, false, 8)
message.Data = ([45 213 53 1 3 213 123 43])
canch = canChannel('Vector', 'CANCaseXL 1', 1)
start(canch)

transmit(canch, message)

To transmit an array, construct messagel and message?2 as in this
example, and type:

transmit(canch, [message, messagel message2?])

To transmit messages on a remote frame, type:

message = canMessage (250, false 8, true)
message.Data = ([45 213 53 1 3 213 123 43])
message.Remote = true

canch = canChannel('Vector', 'CANCaseXL 1', 1)
start(canch)
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transmit(canch, message)

See Also canChannel | canMessage | receive
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Purpose
Syntax

Description

Input
Arguments

Examples

Display messages configured for automatic transmit
transmitConfiguration(canch)

transmitConfiguration(canch) displays information about all
messages in the CAN Channel, canch, configured for periodic transmit
or event-based transmit.

For more information on periodic transmit of messages, refer to
transmitPeriodic.

For more information on event-based transmit of messages, refer to
transmitEvent.

canch

Name of the CAN channel configured for periodic transmit or
event-based transmit.

Create a CAN channel and configure two messages:

canch = canChannel('Vector', 'Virtual 1', 1);
msg1 = canMessage (500, false, 8);
msg2 = canMessage(750, false, 8);

Transmit msgl and msg2 using transmitEvent and transmitPeriodic
respectively:

transmitEvent(canch, msgi, 'On');
transmitPeriodic(canch, msg2, 'On', 1);

Display messages on canch configured for periodic or event-based
transmit:

transmitConfiguration(canch)

The function returns information about periodic configuration:

Periodic Messages



transmitConfiguration

ID Extended Name Data Rate (seconds)

750 false 0000O0OOO 1.000000

Event Messages

ID Extended Name Data
500 false 0000O0O0OO0O
See Also canChannel | canMessage | transmitEvent | transmitPeriodic
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transmitEvent

Purpose
Syntax

Description

Input
Arguments

Examples

See Also
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Configure a message for event-based transmit
transmitEvent(canch, msg, 'state')

transmitEvent(canch, msg, 'state') enables an event-based
transmit of the CAN message, msg, on the channel, canch when ’state
1s On and disables it when ’state’ is Off.

’

canch

The name of the CAN channel on which the specified message is
enabled for event-based transmit.

msg
The message enabled for event-based transmission on the
specified CAN channel.

‘state’

Specify whether event-based transmission is enabled on the
specified message. Input Off to enable event-based transmission
on the specified message, and Off for disabling it.

Construct a CAN channel and configure a message on the channel:

canch = canChannel('Vector', 'CANCaseXL 1', 1);
msg = canMessage (500, false, 4);

Enable the message for event-based transmit, start the channel, and
change some data to trigger the event-based transmit:

transmitEvent(ch, msg, 'On');
start(canch);
msg.Data = [1 2 3 4];

canChannel | canMessage | transmitConfiguration
transmitPeriodic



transmitPeriodic

Purpose

Syntax

Description

Tips

Input
Arguments

Configure a message for periodic transmit

transmitPeriodic(canch, msg, 'On', period)
transmitPeriodic(canch, msg, 'Off')

transmitPeriodic(canch, msg, 'On', period) enables periodic
transmit of the message, msg, on the channel, canch, to transmit at the
specified period, period.

transmitPeriodic(canch, msg, 'Off') disables periodic transmit of
the message, msg, on the channel, canch.

You can enable and disable periodic transmit even when the channel
is running. This functionality allows you to make changes to the state
of the channel without stopping the channel.

canch

The name of the CAN channel on which the specified message is
enabled for periodic transmit.

msg
The message enabled for periodic transmission on the specified
CAN channel.

‘state’
Specify whether periodic transmission is enabled on the specified
message. Input On for enabling periodic transmission on the
specified message and Off to disable it. If you enable periodic
transmission, specify a period value.

period

Specify a period in seconds. This value is used to transmit the
message in the specified period. By default this value is 0.500
seconds.
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transmitPeriodic

Examples
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See Also

Construct a CAN channel and configure a message on the channel:

canch = canChannel('Vector', 'Virtual 1', 1);
msg = canMessage (500, false, 4);

Enable the message for periodic transmit. Set the period value to 1
sec, start the channel, and update the data in the message you want
to send periodically:

transmitPeriodic(canch, msg, 'On', 1);
start(canch);
msg.Data = [1 2 3 4];

canChannel | canMessage | transmitConfiguration | transmitEvent



unpack

Purpose

Syntax

Arguments

Description

Examples

See Also

Unpack signal data from message

value = unpack(message, startbit, signalsize, byteorder,
datatype)

message The CAN message structure that you specify for the
signal to be unpacked from.

startbit The signal’s starting bit in the data. This is the
least significant bit position in the signal data.
Accepted values for starbit are from 0 through 63.

signalsize The length of the signal in bits. Accepted values for
signalsize are from 1 through 64.

byteorder The signal binary or binblock format. Accepted
values are LittleEndian and BigEndian.

datatype The data type that you want to get the unpacked
value in.

value The value of the message that you specify to be
unpacked.

value = unpack(message, startbit, signalsize, byteorder,
datatype) takes a set of input parameters to unpack the signal value
from the message and returns the value as output.

value = unpack(message, 0, 16, 'LittlegEndian', 'int16')

canMessage | extractAll | extractRecent | extractTime | pack
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Property Reference

CAN Channel Base Properties Apply to CAN channels on all devices
(p. 7-2)

Device-Specific Properties (p. 7-5) Apply to CAN channels on specific
devices



7 Property Reference

CAN Channel Base Properties

Channel Status Properties (p. 7-2)

CAN Message Properties (p. 7-2)

CAN Database Properties (p. 7-3)

Receiving Messages (p. 7-3)

Error Logging (p. 7-4)

Channel Status Properties

BusLoad

BusStatus

Database
InitializationAccess
Running

SilentMode

CAN Message Properties

Data
Database
Error
Extended
ID

Name (Message)

Setting properties that specify
different status of CAN channel

Setting properties that specify CAN
message properties

Setting properties of CAN channels
attached to CAN database

Defining actions based on available
messages on CAN channel

Properties for receiving and
transmitting error messages

Display load on CAN bus
Determine status of CAN bus

Store CAN database information
Determine control of device channel
Determine status of CAN channel

Specify if channel is active or silent

Set CAN message data

Store CAN database information
CAN message error frame
Identifier type for CAN message
Identifier for CAN message

CAN message name



CAN Channel Base Properties

Remote

Signals

Timestamp

CAN Database Properties

Messages

Name (Database)
Path

Signals

Receiving Messages

MessageReceivedFcn

MessageReceivedFcnCount

MessagesAvailable

MessagesReceived

MessagesTransmitted

Specify CAN message remote frame

Display physical signals defined in
CAN message

Display message received timestamp

Store message names from CAN
database

CAN database name

Display CAN database directory
path

Display physical signals defined in
CAN message

Specify function to run

Specify number of messages
available before function is triggered

Display number of messages
available to be received by CAN
channel

Display number of messages received
by CAN channel

Display number of messages
transmitted by CAN channel
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Error Logging

ReceiveErrorCount

TransmitErrorCount

Display number of received errors
detected by channel

Display number of transmitted
errors by channel



Device-Specific Properties

Device-Specific Properties

Device Settings (p. 7-5)
Transceiver Settings (p. 7-5)

Bit Timing Settings (p. 7-5)

Device Settings

Device

Device (NI)
DeviceChannelIndex
DeviceSerialNumber

DeviceVendor

Transceiver Settings

TransceiverName

TransceiverState

Bit Timing Settings

BusSpeed
NumOfSamples

SJW

Properties displaying vendor-specific
device information

Properties displaying CAN channel
transceiver information

Properties defining the bit timing
and segmentation

Display CAN channel device type
Display NI CAN channel device type
Display CAN device channel index
Display CAN device serial number

Display device vendor name

Display name of CAN transceiver

Display state or mode of CAN
transceiver

Display speed of CAN bus

Display number of samples available
to channel

Display synchronization jump width
(SJW) of bit time segment
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TSEG1

TSEG2

Display amount that channel can
lengthen sample time

Display amount that channel can
shorten sample time



Properties — Alphabetical
List




BusLoad

Purpose

Description

Characteristics

Values

See Also

Display load on CAN bus

The BusLoad property displays information about the load on the CAN
network for message traffic on Kvaser devices.

Usage CAN channel
Read only Always
Data type Float

The current message traffic on a CAN network is represented as a
percentage ranging from 0.00% to 100.00%.

Functions

canChannel



BusSpeed

Purpose

Description

Characteristics

Values

Examples

See Also

Display speed of CAN bus

The BusSpeed property determines the bit rate at which messages are
transmitted. You can set BusSpeed to an acceptable bit rate using the
configBusSpeed function.

Usage CAN channel
Read only Always
Data type Numerical

The default value is assigned by the vendor driver. To change the bus
speed of your channel, use the configBusSpeed function and pass the
channel name and the value as input parameters.

To change the current BusSpeed of the CAN channel object canch to
250000, type:

configBusSpeed(canch, 250000)
Functions
canChannel, configBusSpeed

Properties
NumOfSamples, SUW, TSEG1, TSEG2



BusStatus

Purpose Determine status of CAN bus
Description The BusStatus property displays information about the state of the
CAN bus.
Characteristics ygage CAN channel
Read only Always
Data type String
Values e N/A
® BusOff
® ErrorOff

® ErrorActive

See Also Functions

canChannel
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Data

Purpose

Description

Characteristics

Values

Examples

See Also

Set CAN message data

Use the Data property to define your message data in a CAN message.

Usage CAN message
Read only Never
Data type Numeric

The data value is a uint8 array, based on the data length you specify
in the message.

To load data into a message, type:

message.Data = [23 43 23 43 54 34 123 1]

If you are using a CAN database for your message definitions, change
values of the specific signals in the message directly.

You can also use the pack function to load data into your message.

Functions

canMessage, pack



Database
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Purpose

Description

Characteristics ygage

Values

Examples

Store CAN database information

The Database property stores information about an attached CAN
database.

CAN channel, CAN message
Read only For a CAN message property
Data type Database handle

This property displays the database information that your CAN channel
or CAN message is attached to. This property displays an empty
structure, [ ], if your channel message is not attached to a database.
You can edit the CAN channel property, Database, but cannot edit

the CAN message property.

To see information about the database attached to your CAN message,
type:

message.Database

To set the database information on your CAN channel to
C:\Database.dbc, type:

channel.Database = canDatabase('C:\Database.dbc')

Tip CAN database file names containing non-alphanumeric characters
such as equal signs, ampersands, and so forth are incompatible with
Vehicle Network Toolbox. You can use a period sign in your database
name. Rename any CAN database files with non-alphanumeric
characters before you use them.




Database

See Also Functions

attachDatabase, canChannel, canDatabase, canMessage
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Device

Purpose

Description

Characteristics

Values

See Also

Display CAN channel device type
For National Instruments devices, the Device property displays the
device number on the hardware.

For all other devices, the Device property displays information about
the device type to which the CAN channel is connected.

Usage CAN channel
Read only Always
Data type String

Values are automatically defined when you configure the channel with
the canChannel function.

Functions

canChannel, canHWInfo

Properties

DeviceChannelIndex, DeviceType, DeviceVendor



Device(NI)

Purpose

Description

Characteristics

Values

See Also

Display NI CAN channel device type

For National Instruments devices, the DeviceType property displays
information about the device type to which the CAN channel is
connected.

Usage CAN channel
Read only Always
Data type String

Values are automatically defined when you configure the channel with
the canChannel function.

Functions

canChannel, canHWInfo

Properties

DeviceChannelIndex, DeviceVendor



DeviceChannellndex

8-10

Purpose

Description

Characteristics

Values

See Also

Display CAN device channel index

The DeviceChannelIndex property displays the channel index on which
the selected CAN channel is configured.

Usage CAN channel
Read only Always
Data type Numeric

Values are automatically defined when you configure the channel with
the canChannel function.

Functions

canChannel, canHWInfo

Properties

Device, DeviceVendor



DeviceSerialNumber

Purpose Display CAN device serial number
Description The DeviceSerialNumber property displays the serial number of the
CAN device.
Characteristics ygage CAN channel
Read only Always
Data type ® Numeric

¢ Hexadecimal String (NI CAN devices only)

Values Values are automatically defined when you configure the channel with
the canChannel function.

See Also Functions

canChannel, canHWInfo

Properties

Device, DeviceVendor
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DeviceVendor

Purpose Display device vendor name
Description The DeviceVendor property displays the name of the device vendor.
Characteristics ygage CAN channel
Read only Always
Data type String
Values Values are automatically defined when you configure the channel with

the canChannel function.

See Also Functions

canChannel, canHWInfo

Properties

Device, DeviceChannelIndex, DeviceSerialNumber
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Error

Purpose

Description

Characteristics

Values

See Also

CAN message error frame

The Error property is a read-only value that identifies the specified
CAN message as an error frame. The channel sets this property to true
when it receives a CAN message as an error frame.

Usage CAN message
Read only Always
Data type Boolean

e false — The message is not an error frame.

¢ true — The message is an error frame.

The Error property displays false, unless the message is an error
frame.

Functions

canMessage
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Extended

Purpose

Description

Characteristics

Values

Examples

See Also

8-14

Identifier type for CAN message

The Extended property is the identifier type for a CAN message. It can
either be a standard identifier or an extended identifier.

Usage CAN message
Read only Always
Data type Boolean

¢ false — The identifier type is standard (11 bits).
¢ true — The identifier type is extended (29 bits).

To set the message identifier type to extended with the ID set to 2350
and the data length to 8 bytes, type:

message = canMessage (2350, true, 8)
You cannot edit this property after the initial configuration.

Functions

canMessage

Properties
ID



ID

Purpose

Description

Characteristics

Values

Examples

See Also

Identifier for CAN message

The ID property represents a numeric identifier for a CAN message.

Usage CAN message
Read only Always
Data type Numeric

The ID value must be a positive integer from:

¢ 0 through 2047 for a standard identifier
¢ 0 through 536,870,911 for an extended identifier

You can also specify a hexadecimal value using the hex2dec function.

To configure a message ID to a standard identifier of value 300 and a
data length of 8 bytes, type:

message = canMessage (300, false, 8)

Functions

canMessage

Properties
Extended
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InitializationAccess
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Purpose

Description

Characteristics

Values

See Also

Determine control of device channel

The InitializationAccess property determines if the configured CAN
channel object has full control of the device channel. You can change
some property values of the hardware channel only if the object has full
control over the hardware channel.

Note Only the first channel created on a device is granted initialization

access.
Usage CAN channel
Read only Always
Data type Boolean

® Yes — Has full control of the hardware channel and can change the
property values.

® No — Does not have full control and cannot change property values.

Functions

canChannel



MessageReceivedFcn

Purpose Specify function to run

Description Configure MessageReceivedFcn as a callback function to run a string
expression, a function handle, or a cell array when a specified number
of messages are available.

The MessageReceivedFcnCount property defines the number of
messages available before the configured MessageReceivedFcn runs.

Characteristics ygage CAN channel
Read only Never
Data type Callback function
Values The default value is an empty string. You can specify the name of a

callback function that you want to run when the specified number of
messages are available.

Examples canch.MessageReceivedFcn = @Myfunction
You can also use the set function to set the values of this property.

See Also Functions

canChannel, set

Properties

MessageReceivedFcnCount, MessagesAvailable
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MessageReceivedFcnCount

Purpose Specify number of messages available before function is triggered

Description Configure MessageReceivedFcnCount to the number of messages that
must be available before a MessageReceivedFcn is triggered.

Characteristics ygage CAN channel
Read only While channel is online
Data type Double
Values The default value is 1. You can specify a positive integer for your

MessageReceivedFcnCount.
Examples canch.MessageReceivedFcnCount = 55
You can also use the set function to set the values of this property.

See Also Functions

canChannel, set

Properties

MessageReceivedFcn, MessagesAvailable
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Messages

Purpose

Description

Characteristics

Values

See Also

Store message names from CAN database

The Messages property stores the names of all messages defined in
the selected CAN database.

Usage CAN database
Read only Always
Data type String

The Messages property displays a cell array of strings. You cannot
edit this property.

canDatabase, messageInfo
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MessagesAvailable
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Purpose

Description

Characteristics

Values

See Also

Display number of messages available to be received by CAN channel

The MessagesAvailable property displays the total number of
messages available to be received by a CAN channel.

Usage CAN channel
Read only Always
Data type Double

The value is 0 when no messages are available.
Functions
canChannel

Properties

MessagesReceived, MessagesTransmitted



MessagesReceived

Purpose

Description

Characteristics

Values

See Also

Display number of messages received by CAN channel

The MessagesReceived property displays the total number of messages
received since the channel was last started.

Usage CAN channel
Read only Always
Data type Double

The value is 0 when no messages have been received. This number
increments based on the number of messages the channel receives.

Functions

canChannel, canHWInfo

Properties

MessagesAvailable, MessagesTransmitted
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MessagesTransmitted
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Purpose

Description

Characteristics

Values

See Also

Display number of messages transmitted by CAN channel

The MessagesTransmitted property displays the total number of
messages transmitted since the channel was last started.

Usage CAN channel
Read only Always
Data type Double

The default is 0 when no messages have been sent. This number
increments based on the number of messages the channel transmits.

Functions
canChannel

Properties

MessagesAvailable, MessagesReceived



Name (Database)

Purpose

Description

Characteristics

Values

See Also

CAN database name

The Name (Database) property displays the name of the database.

Usage CAN database
Read only Always
Data type String

Name is a string value. This value is acquired from the name of the
database file. You cannot edit this property.

Functions

canDatabase

Properties
Extended, ID
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Name (Message)

Purpose CAN message name
Description The Name (Message) property displays the name of the message.
Characteristics ygage CAN message
Read only Always
Data type String
Values Name is a string value. This value is acquired from the name of the

message you defined in the database. You cannot edit this property if
you are defining raw messages.

See Also Functions

canMessage

Properties
Extended, ID
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NumOfSamples

Purpose

Description

Characteristics

Values

See Also

Display number of samples available to channel

The NumOfSamples property displays the total number of samples
available to this channel. If you do not specify a value, the BusSpeed
property determines the default value.

Note This property is not available for National Instruments CAN
devices. The channel displays NaN for the value.

Usage CAN channel
Read only Always
Data type Double

The value is a positive integer based on the driver settings for the
channel.

Functions

canChannel, configBusSpeed

Properties
BusSpeed, SJW, TSEG1, TSEG2
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Path

Purpose Display CAN database directory path
Description The Path property displays the path to the CAN database.
Characteristics ygage CAN database
Read only Always
Data type String
Values The path name is a string value, pointing to the CAN database in your
directory structure.
See Also Functions
canDatabase
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ReceiveErrorCount

Purpose

Description

Characteristics

Values

See Also

Display number of received errors detected by channel

The ReceiveErrorCount property displays the total number of errors
detected by this channel during receive operations.

Usage CAN channel
Read only Always
Data type Double

The value is 0 when no error messages have been received.

Functions

canChannel, receive

Properties

TransmitErrorCount
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Remote
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Purpose

Description

Characteristics

Values

Examples

See Also

Specify CAN message remote frame

Use the Remote property to specify the CAN message as a remote frame.

Usage CAN message
Read only Never
Data type Boolean

e [false} — The message is not a remote frame.

® true — The message is a remote frame.

To change the default value of Remote and make the message a remote
frame, type:

message.Remote = true

Functions

canMessage



Purpose

Description

Characteristics

Values

See Also

Determine status of CAN channel

The Running property displays information about the state of the CAN
channel.

Usage CAN channel
Read only Always
Data type Boolean

e [false} — The channel is offline.

e true — The channel is online.

Use the start function to set your channel online.

Functions

canChannel, start
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SilentMode
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Purpose

Description

Characteristics

Values

Examples

See Also

Specify if channel is active or silent

Specify whether the channel operates silently. By default SilentMode
is false. In this mode, the channel both transmits and receives
messages normally and performs other tasks on the network such as
acknowledging messages and creating error frames.

To observe all message activity on the network and perform analysis
without affecting the network state or behavior, change SilentMode to
true. In this mode, you can only receive messages and not transmit any.

Usage CAN channel
Read only Never
Data type Boolean

e [false} — The channel is in normal or active mode.

¢ true — The channel is in silent mode.

To configure the channel to silent mode, type:
canch.SilentMode = true

To configure the channel to normal mode, type:
canch.SilentMode = false

You can also use the set function to set the values of this property.

Functions

canChannel, set



Signals
|

Purpose Display physical signals defined in CAN message

Description The Signals property allows you to view and edit signal values defined
for a CAN message. This property displays an empty structure if the
message has no defined signals or a CAN database is not attached to the
message. The input values for this property depends on the signal type.

Characteristics ygage CAN message
Read only Sometimes
Data type Structure
Examples Display signals defined in the CAN message, message:

message.Signals
ans =

VehicleSpeed: 0
EngineRPM: 250

Change the value of a signal:

message.Signals.EngineRPM = 300

See Also Functions

canMessage, canDatabase
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SIW
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Purpose

Description

Characteristics

Values

See Also

Display synchronization jump width (SJW) of bit time segment

In order to adjust the on-chip bus clock, the CAN controller may shorten
or prolong the length of a bit by an integral number of time segments.
The maximum value of these bit time adjustments are termed the
synchronization jump width or SJW.

Note This property is not available for National Instruments CAN
devices. The channel displays NaN for the value.

Usage CAN channel
Read only Always
Data type Numeric

The value of the SJW is determined by the specified bus speed.

Functions

canChannel, configBusSpeed

Properties
BusSpeed, NumOfSamples, TSEG1, TSEG2



Timestamp

Purpose

Description

Characteristics

Values

Examples

See Also

Display message received timestamp

The Timestamp property displays the time at which the message
was received on a CAN channel. This time is based on the receiving
channel’s start time.

Usage CAN message
Read only Never
Data type Double

Timestamp displays a numeric value indicating the time the message
was received, based on the start time of the CAN channel

To set the time stamp of a message to 12, type:

message.Timestamp = 12

Functions

canChannel, canMessage, receive, replay
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TransceiverName
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Purpose

Description

Characteristics

Values

See Also

Display name of CAN transceiver

The CAN transceiver translates the digital bit stream going to and
coming from the CAN bus into the real electrical signals present on
the bus.

Usage CAN channel
Read only Always
Data type String

Values are automatically defined when you configure the channel with
the canChannel function.

Functions
canChannel

Properties

TransceiverState



TransceiverState

Purpose Display state or mode of CAN transceiver

Description If your CAN transceiver allows you to control its mode, you can use the
TransceiverState property to set the mode.

Characteristics ygage CAN channel
Read only Never
Data type Numeric
Values The values are defined by the transceiver manufacturer. Refer to your

CAN transceiver documentation for the appropriate transceiver modes.
Possible modes representing the numeric value specified are:

® high speed

® high voltage

® sleep

® wake up

See Also Functions

canChannel

Properties

TransceiverName
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TransmitErrorCount
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Purpose

Description

Characteristics

Values

See Also

Display number of transmitted errors by channel

The TransmitErrorCount property displays the total number of errors
detected by this channel during transmit operations.

Usage CAN channel
Read only Always
Data type Double

The value is 0 when no error messages have been transmitted.

Functions

canChannel, transmit

Properties

ReceiveErrorCount



TSEG1

Purpose Display amount that channel can lengthen sample time

Description The TSEG1 property displays the amount in bit time segments that the
channel can lengthen the sample time to compensate for delay times
in the network.

Note This property is not available for National Instruments CAN
devices. The channel displays NaN for the value.

Characteristics ygage CAN channel
Read only Always
Data type Double
Values The value is inherited when you configure the bus speed of your CAN
channel.
See Also Functions

canChannel, configBusSpeed

Properties
BusSpeed, NumOfSamples, SJUW, TSEG2
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TSEG2

Purpose Display amount that channel can shorten sample time

Description The TSEG2 property displays the amount of bit time segments the
channel can shorten the sample to resynchronize.

Note This property is not available for National Instruments CAN
devices. The channel displays NaN for the value.

Characteristics ygage CAN channel
Read only Always
Data type Double
Values The value is inherited when you configure the bus speed of your CAN
channel.
See Also Functions

canChannel, configBusSpeed

Properties
BusSpeed, NumOfSamples, SJW, TSEG1
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CAN Configuration

Purpose
Library

Description

Configure parameters for specified CAN device

Vehicle Network Toolbox: CAN Communication

Wector CANcaseXL 1
Channel 1
Bus speed: 500000

CAN Configuration

The CAN Configuration block configures parameters for a CAN device
that you can use to transmit and receive messages.

Specify the configuration of your CAN device before you configure other
CAN blocks.

Use one CAN Configuration block to configure each device that sends
and receives messages in your model. If you use a CAN Receive or a
CAN Transmit block to receive and send messages on a device, your
model checks to see if there is a corresponding CAN Configuration block
for the specified device. If the device is not configured, you will see a
prompt advising you to use a CAN Configuration block to configure

the specified device.

Note You need a license for both Vehicle Network Toolbox and
Simulink software to use this block.

Other Supported Features

The CAN Configuration block supports the use of Simulink®
Accelerator™ mode. Using this feature, you can speed up the execution
of Simulink models.

For more information on this feature, see the Simulink documentation.

The CAN Configuration block supports the use of code generation when
you use it with the CAN Receive and CAN Transmit blocks.



CAN Configuration
|

Dialog Use the Block Parameters dialog box to select your CAN device
Box configuration.

x

—CAM Configuration

Configure the properties for the spedfied CAN device,

—Parameters
Device: Ii.-'ecb:-r CAMcaseXL 1 {Channel 1) LI
Busspeed: 500000

[~ Enable bit parameters manually:

Synchronization jump width: I 1

Time segment 1: |—1
Time segment 2: I 3
Mumber of samples: I 1

vierify bit parameter settings validity ... |

Acknowledge mode: INormaI ;I

CK. I Cancel | Help | Apply |

Device
Select the CAN device and a channel on the device that you want
to use from the list. Use this device to transmit and/or receive
messages. The device driver determines the default bus speed.

Bus speed
Set the bus speed property for the selected device. The default
bus speed is the default assigned by the selected device.

Enable bit parameters manually

Note This option is disabled if you are using an NI CAN channel.
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CAN Configuration
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Select this check box to specify bit parameter settings manually.
The bit parameter settings include:

Synchronization jump width, Time segment 1, Time
segment 2, and Number of samples. If you do not select this
option, the device automatically assigns the bit parameters
depending on the bus speed setting.

Tip Use the default bit parameter settings unless you have
specific timing requirements for your CAN connection.

Synchronization jump width

Specify the maximum value of the bit time adjustments. The
specified value must be a positive integer. If you do not specify
a value, the selected bus speed setting determine the default
value. To change this value, select the Enable bit parameters
manually check box first. Refer to the SUW property for more
information.

Time segment 1

Specify the amount of bit time segments that the channel can
lengthen the sample time. The specified value must be a positive
integer. If you do not specify a value, the selected bus speed
setting determines the default value. To change this value, select
the Enable bit parameters manually check box first. Refer to
the TSEG1 property for more information.

Time segment 2

Specify the amount of bit time segments that the channel can
shorten the sample time to resynchronize. The specified value
must be a positive integer. If you do not specify a value, the
selected bus speed setting determines the default value. To
change this value, select the Enable bit parameters manually
check box first. Refer to the TSEG2 property for more information.



CAN Configuration

Number of samples
Specify the total number of samples available to this channel. The
specified value must be a positive integer. If you do not specify
a value, the selected bus speed setting determines the default
value. To change this value, select the Enable bit parameters
manually check box first. Refer to the NumOfSamples property
for more information.

Verify bit parameter settings validity
If you have set the bit parameter settings manually, click this
button to see if your settings are valid. The block then runs a
check to see if the combination of your bus speed setting and the
bit parameter value forms a valid value for the CAN device. If the
new bit parameter values do not form a valid combination, the
verification fails and displays an error message.

Acknowledge mode
Specify whether the channel is in Normal or Silent mode. By
default Acknowledge mode is Normal. In this mode, the
channel both receives and transmits messages normally and
performs other tasks on the network such as acknowledging
messages and creating error frames. To observe all message
activity on the network and perform analysis, without affecting
the network state or behavior, select Silent. In Silent mode, you
can only receive messages and not transmit.

Notes

® You cannot specify the mode if you are using NI virtual
channels.

¢ Use Silent mode only if you want to observe and analyze your
network activity.

See Also CAN Receive, CAN Transmit
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Purpose Pack individual signals into CAN message

Librclry CAN Communication
Embedded Coder/ Embedded Targets/ Host Communication

L L
Description
Signall
Signal? DriverDoorLodk
Dats IMessage: CAN NMsg CAN Msg g IMessage: CAN Msg CAN Msg File: demoWNT_CANdbFiles.dbc
Standard |D: 250 ' Signalz Standard ID0: 250 ' Message: DoorContrelsg  CAN Msg
. Standard 1D0: 250
Signal4 PassengerDoorLod:
CAN Padk CAN Padk
[With raw data input) [With manuslly specified data input)

CAN Padk
(With CANdb specified data input)

The CAN Pack block loads signal data into a message at specified
intervals during the simulation.

Note To use this block, you also need a license for Simulink software.

CAN Pack block has one input port by default. The number of input
ports is dynamic and depends on the number of signals you specify
for the block. For example, if your block has four signals, it has four
input ports.

Signali
Signalz hessage: CAN hsg
. Standard |b: 250 CAN Msgp
Signal3
Signald

CAN Fack

This block has one output port, CAN Msg. The CAN Pack block takes
the specified input parameters and packs the signals into a message.
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Other Supported Features

The CAN Pack block supports:

® The use of Simulink Accelerator mode. Using this feature, you can
speed up the execution of Simulink models.

® The use of model referencing. Using this feature, your model can
include other Simulink models as modular components.

¢ Code generation using Simulink® Coder™ to deploy models to targets.

Note Code generation is not supported if your signal information
consists of signed or unsigned integers greater than 32-bits long.

For more information on these features, see the Simulink
documentation.
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Dialog Use the Function Block Parameters dialog box to select your CAN Pack
Box block parameters.
x
—CAN Pack
Pack data into a CAN Message.
—Parameters
Data is input as: |raw data LI
CANdb file: I Browse... |
Message list: I(none} LI
—Message
MName: ICAN Msg
Identifier type: IStandard {11-bit identifier) ;I
Identifier: I 250
Length (bytes): |B
[ Remote frame

QK I Cancel Help Apply

Parameters

Data is input as
Select your data signal:

¢ raw data: Input data as a uint8 vector array. If you select this
option, you only specify the message fields. All other signal
parameter fields are unavailable. This option opens only one
input port on your block.

¢ manually specified signals: Allows you to specify data signal
definitions. If you select this option, use the Signals table to
create your signals. The number of input ports on your block
depends on the number of signals you specify.
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x
—CAN Pack
Pack data into a CAN Message,
—Parameters
Data is input as: |manually spedified signals LI
CANdb file: I Browse... |
Message list: I(none) LI
—Message
Mame: IC.-'-\N Msg
Identifier type: IStandard {11-bit identifier) LI
Identifier: I 250
Length {bytes): |8
™ Remote frame
Signals: Add signal Delete signal
Name Ei‘frt t;’;f}m E:’;:r E:pf ’t‘:ﬂ:de“ T;'L:’:"e" Factor |Offset |Min |Max
Signall 1] 8|LE = ||signed LlStandard hd 1] 1 0| -Inf| Inf
Signal2 8 sfie =lfsigned  =[fstandard v 0 1 0| Inf| Inf
Signal3 16 8|l =|lsigned  =llstandard =] 0 1 0| dnf| Inf
Signal4| 24 8|l =llsigned  =llstandard =] 0 1 0| dnf| Inf
QK I Cancel | Help | Apply |

¢ CANdb specified signals: Allows you to specify a CAN

database file that contains message and signal definitions.

If

you select this option, select a CANdb file. The number of input
ports on your block depends on the number of signals specified

in the CANdDb file for the selected message.

Note You can specify a CAN database file only on a Windows

32-bit machine.
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x
—CAN Pack
Pack data into a CAN Message,
—Parameters
Data is input as: |C.-'-\Ndb specified signals LI
CANdb file: ICANdeiIes.dbc Browse... |
Message list: IDoorCDnh'olMsg LI
—Message
Mame: I DoorControlMsg
Identifier type: IStandard {11-bitidentifier) LI
Identifier: |4DD
Length (bytes): |8
™ Remote frame
Signals: Add signal Delete signal
Name Ei‘frt t:i';f}m E:’;:r E;p‘:’ ’t‘lﬂ:p‘e" T;'L:’:"e" Factor |Offset |Min |Max
DriverD 1 1LE = Jjunsigned LI Standard x| o] 1 1] 1] 1
Passeny 1] 1LE = Jjunsigned LIIStandard hd o] 1 1] 1] 1
0K I Cancel | Help | Apply

CANdb file

This option is available if you specify that your data is input via
a CANdb file in the Data is input as list. Click Browse to find
the appropriate CANdb file on your system. The message list
specified in the CANdD file populates the Message section of the
dialog box. The CANdb file also populates the Signals table for

the selected message.

Message list

This option is available if you specify that your data is input via a
CAN(db file in the Data is input as field and you select a CANdb
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file in the CANdDb file field. Select the message to display signal
details in the Signals table.

Message

Name

Specify a name for your CAN message. The default is CAN

Msg. This option is available if you choose to input raw data or
manually specify signals. This option in unavailable if you choose
to use signals from a CANdD file.

Identifier type

Specify whether your CAN message identifier is a Standard or an
Extended type. The default is Standard. A standard identifier

is an 11-bit identifier and an extended identifier is a 29-bit
identifier. This option is available if you choose to input raw data
or manually specify signals. For CANdb specified signals, the
Identifier type inherits the type from the database.

Identifier

Specify your CAN message ID. This number must be a positive
integer from O through 2047 for a standard identifier and from
0 through 536870911 for an extended identifier. You can also
specify hexadecimal values using the hex2dec function. This
option is available if you choose to input raw data or manually
specify signals.

Length (bytes)

Specify the length of your CAN message from 0 to 8 bytes. If you
are using CANdb specified signals for your data input, the
CAN(db file defines the length of your message. If not, this field
defaults to 8. This option is available if you choose to input raw
data or manually specify signals.

Remote frame

Specify the CAN message as a remote frame.

9-11



CAN Pack

Signals Table

This table appears if you choose to specify signals manually or define
signals using a CANdb file.

If you are using a CANdb file, the data in the file populates this table
automatically and you cannot edit any fields. To edit signal information,
switch to manually specified signals.

If you have selected to specify signals manually, create your signals
manually in this table. Each signal you create has the following values:

Name
Specify a descriptive name for your signal. The Simulink block
in your model displays this name. The default is Signal [row
number].

Start bit
Specify the start bit of the data. The start bit is the least
significant bit counted from the start of the message data. The
start bit must be an integer from O through 63.

Length (bits)
Specify the number of bits the signal occupies in the message. The
length must be an integer from 1 through 64.

Byte order
Select either of the following options:

e LE: Where the byte order is in little-endian format (Intel®).
In this format you count bits from the start, which is the
least significant bit, to the most significant bit, which has the
highest bit index. For example, if you pack one byte of data in
little-endian format, with the start bit at 20, the data bit table
resembles this figure.
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Bit Number

Bit 7

Bit6

Bit5

Bit 4

Bit3

Bit 2

Bit1l

Bit 0

Byte 0

Data Byte Number

15

3l

14

a0

13

23

12

Data be

qgins at the least si

gnificant

11

10

Byte 3 bit and starts at 20

a9 as a7 a6 s 34 a3 3z

Data is writen up to the most significant

Byte 4 bit and ends at 27

47 a6 45 44 43 42 41 40
Byte §

55 54 53 52 51 50 43 43
Byte 6

63 62 &1 60 59 58 57 56
Byte 7

Little-Endian Byte Order Counted from the Least Significant Bit
to the Highest Address

BE: Where byte order is in big-endian format (Motorola®). In
this format you count bits from the start, which is the least
significant bit, to the most significant bit. For example, if you
pack one byte of data in big-endian format, with the start bit at
20, the data bit table resembles this figure.
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9-14

Bit Number

Bit7

Data Byte Number

18

17

Data iswriten up to the most
significant bit and ends at |11
31 a0 29 27 26 5 24
Data begins at the least significant
Byte 3 it and starts at 20
a9 L a7 a6 as 34 a3 az
Byte 4
47 a6 45 44 43 42 41 40
Byte §
55 54 53 52 51 50 43 43
Byte 6
63 62 61 &0 59 58 57 56
Byte 7

Big-Endian Byte Order Counted from the Least Significant Bit
to the Lowest Address

Data type
Specify how the signal interprets the data in the allocated bits.

Choose from:

signed (default)

unsigned
single
double
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Multiplex type
Specify how the block packs the signals into the CAN message
at each timestep:

e Standard: The signal is always packed at each timestep.

® Multiplexor: The Multiplexor signal, or the mode signal is
always packed. You can specify only one Multiplexor signal
per message.

e Multiplexed: The signal is packed if the value of the
Multiplexor signal (mode signal) at run time matches the
configured Multiplex value of this signal.

For example, a message has four signals with the following types

and values.
Signal Name Multiplex Type Multiplex Value
Signal-A Standard N/A
Signal-B Multiplexed 1
Signal-C Multiplexed 0
Signal-D Multiplexor N/A

In this example:

¢ The block packs Signal-A (Standard signal) and Signal-D
(Multiplexor signal) in every timestep.

e [f the value of Signal-D is 1 at a particular timestep, then the
block packs Signal-B along with Signal-A and Signal-D in that
timestep.

e [f the value of Signal-D is 0 at a particular timestep, then the
block packs Signal-C along with Signal-A and Signal-D in that
timestep.

e [f the value of Signal-D is not 1 or 0, the block does not pack
either of the Multiplexed signals in that timestep.
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Multiplex value
This option is available only if you have selected the Multiplex
type to be Multiplexed. The value you provide here must match
the Multiplexor signal value at run time for the block to pack
the Multiplexed signal. The Multiplex value must be a positive
integer or zero.

Factor
Specify the Factor value to apply to convert the physical value
(signal value) to the raw value packed in the message. See
“Conversion Formula” on page 9-16 to understand how physical
values are converted to raw values packed into a message.

Offset
Specify the Offset value to apply to convert the physical value
(signal value) to the raw value packed in the message. See
“Conversion Formula” on page 9-16 to understand how physical
values are converted to raw values packed into a message.

Min
Specify the minimum physical value of the signal. The default
value 1s -inf (negative infinity). You can specify any number
for the minimum value. See “Conversion Formula” on page 9-16
to understand how physical values are converted to raw values
packed into a message.

Max
Specify the maximum physical value of the signal. The default
value is inf. You can specify any number for the maximum
value. See “Conversion Formula” on page 9-16 to understand
how physical values are converted to raw values packed into a
message.

Conversion Formula

The conversion formula is

raw_value = (physical_value - Offset) / Factor
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|

where physical value is the value of the signal after it is saturated
using the specified Min and Max values. raw_value is the packed
signal value.

See Also CAN Unpack
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Purpose Receive CAN messages from specified CAN device
Librclry Vehicle Network Toolbox: CAN Communication

Description

Vector CANcaseXL 1 1
Channsl 1 )

Std. IDs: all .
Ext. IDs: all CAN Msg £

CAM Receive

The CAN Receive block receives messages from the CAN network and
delivers them to the Simulink model. It outputs one message or all
messages at each timestep, depending on the block parameters.

Note You need a license for both Vehicle Network Toolbox and
Simulink software to use this block.

The CAN Receive block has two output ports:

¢ The f() output port is a trigger to a Function-Call subsystem. If
the block receives a new message, it triggers a Function-Call from
this port. You can then connect to a Function-Call Subsystem to
unpack and process a message.

® The CAN Msg output port contains a CAN message received at that

particular timestep.

The CAN Receive block stores CAN messages in a first-in, first-out
(FIFO) buffer. The FIFO buffer delivers the messages to your model in
the queued order at every timestep.
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Code
Generation

Note You cannot have more than one Receive block connected to the
same NI device channel.

Other Supported Feature

The CAN Receive block supports the use of Simulink Accelerator mode.
Using this feature, you can speed up the execution of Simulink models.

For more information on this feature, see the Simulink documentation.

The CAN Receive block supports the use of code generation along with
the packNGo function to group required source code and dependent
shared libraries. For more information, see Code Generation.

Vehicle Network Toolbox Simulink blocks allow you to generate
code, enabling models containing these blocks to run successfully in
Accelerator, Rapid Accelerator, External, and Deployed modes.

Code Generation with the Simulink Coder

You can use Vehicle Network Toolbox, Simulink Coder, and Embedded
Coder™products together to generate code (on the host end) that you
can use to implement your model for a practical application. For more
information on code generation, see Building Executables.

Shared Library Dependencies

The block generates code with limited portability. The block uses
precompiled shared libraries, such as DLLs, to support I/O for specific
types of devices. With this block, you can use the packNGo function
supported by the Simulink Coder, to set up and manage the build
information for your models. The packNGo function allows you to
package model code and dependent shared libraries into a zip file for
deployment. You do not need MATLAB installed on the target system,
but the target system needs to be supported by MATLAB.

To set up packNGo:
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set_param(gcs, 'PostCodeGenCommand’,
"packNGo (buildInfo)');

In this example, gcs is the current model that you wish to build.
Building the model creates a zip file with the same name as model
name. You can move this zip file to another machine and the source
code in the zip file can be built to create an executable which can be run
independent of MATLAB and Simulink. The generated code compiles
with both C and C++ compilers. For more information on packNGo,

see packNGo.

Dialog Use the Source Block Parameters dialog box to select your CAN Receive
Box block parameters.

Tip Configure your CAN Configuration block before you configure the
CAN Receive block parameters.

=] Source Block Parameters: CAN Receive x|

—CAN Receive

Receive CAM Messages using the specified CAN device.

—Parameters

Device:

[~ Filter for accepted Standard IDs range

o Example: [100 [110:115]]

[ Filter for accepted Extended IDs range

o Example: [4000 [4100:4105]]

Sample time: IU.DI

Mumber of messages received at each timestep: IaII LI

OK I Cancel | Help |
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Device
Select the CAN device and a channel on the device you want
to receive CAN messages from. This field lists all the devices
installed on the system. It displays the vendor name, the device
name, and the channel ID. The default is the first available device
on your system.

Filter for accepted Standard IDs range
Select this check box to accept a specific range of standard IDs.
By default, the CAN Receive block accepts all standard IDs.
Enter the ID ranges in the text field. You can specify a single ID
or an array of IDs. You can also specify disjointed IDs or arrays
separated by a comma. For example, to accept IDs from 400
through 500 and 600 through 650, enter [ [400:500] [600:650]].
Standard IDs must be a positive integer from 0 through 2047. You
can also specify a hexadecimal value using the hex2dec function.

Filter for accepted Extended IDs range
Select this check box to accept a specific range of extended IDs.
By default the CAN Receive block accepts all extended IDs.
Enter the ID ranges in the text field. You can specify an array
of IDs separated by commas. For example, to accept IDs from
3000 through 3500 and 3600 through 3620, enter [ [3000:3500]
[3600:3620]]. Extended IDs must be a positive integer from 0
through 536870911. You can also specify a hexadecimal value
using the hex2dec function.

Sample time
Specify the sampling time of the block during simulation, which is
the simulation time as described by the Simulink documentation.
This value defines the frequency at which the CAN Receive
block runs during simulation. If the block is inside a triggered
subsystem or to inherit sample time, you can specify —1 as your
sample time. The default value is 0.01 (in seconds).

Number of messages received at each timestep
Select how many messages the block receives at each specified
timestep. The choices are 1 and all. By default, the block receives
one message at each timestep. Then, the FIFO buffer delivers
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one new message to the Simulink model. If the block does not
receive any message before the next timestep it outputs the last
received message.

If you select all, the CAN Receive block delivers all available
messages in the FIFO buffer to the model during a specific
timestep. The block generates one function call for every message
delivered to the model for that particular timestep. The output
port always contains one CAN message at a time.

See Also CAN Configuration, CAN Unpack
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Purpose
Library

Description

Transmit CAN message to selected CAN device

Vehicle Network Toolbox: CAN Communication

CAN Msg

Wector CANcaseXL 1
Channel 1

CAN Transmit

The CAN Transmit block transmits messages to the CAN network
using the specified CAN device. The CAN Transmit block can transmit
a single message or an array of messages during a given timestep. To
transmit an array of messages, use a mux (multiplex) block from the
Simulink block library.

Note You need a license for both Vehicle Network Toolbox and
Simulink software to use this block.

The CAN Transmit block has one input port. This port accepts a CAN
message packed using the CAN Pack block. It has no output ports.

Other Supported Feature

The CAN Transmit block supports the use of Simulink Accelerator
mode. Using this feature, you can speed up the execution of Simulink
models.

For more information on this feature, see the Simulink documentation.

The CAN Transmit block supports the use of code generation along with
the packNGo function to group required source code and dependent
shared libraries. For more information, see Code Generation.
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Code Vehicle Network Toolbox Simulink blocks allow you to generate
Generation code, enabling models containing these blocks to run successfully in
Accelerator, Rapid Accelerator, External, and Deployed modes.

Code Generation with the Simulink Coder

You can use Vehicle Network Toolbox, Simulink Coder, and Embedded
Coderproducts together to generate code (on the host end) that you
can use to implement your model for a practical application. For more
information on code generation, see Building Executables.

Shared Library Dependencies

The block generates code with limited portability. The block uses
precompiled shared libraries, such as DLLs, to support I/O for specific
types of devices. With this block, you can use the packNGo function
supported by the Simulink Coder, to set up and manage the build
information for your models. The packNGo function allows you to
package model code and dependent shared libraries into a zip file for
deployment. You do not need MATLAB installed on the target system,
but the target system needs to be supported by MATLAB.

To set up packNGo:

set_param(gcs, 'PostCodeGenCommand’,
"packNGo (buildInfo) ');

In this example, gcs is the current model that you wish to build.
Building the model creates a zip file with the same name as model
name. You can move this zip file to another machine and the source
code in the zip file can be built to create an executable which can be run
independent of MATLAB and Simulink. The generated code compiles
with both C and C++ compilers. For more information on packNGo,

see packNGo.
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Dialog Use the Sink Block Parameters dialog box to select your CAN Transmit
Box block parameters.

Tip Configure your CAN Configuration block before you configure the
CAN Transmit block parameters.

= sink Block Parameters: CAN Transmit x|

—CAM Transmit

Transmit CAMN Messages using the specified CAM device.

—Parameters

[~ Tranzmit messages periodically

Message period {in seconds): I 1.000 ;I

0K Cancel Help | Apply |

Device
Select the CAN device and a channel on the device to use to
transmit CAN messages to the network. This list shows all the
devices installed on the system. It displays the vendor name, the
device name, and the channel ID. The default is the first available
device on your system.

Transmit messages periodically
Select this option to enable periodic transmit of the message on
the configured channel to transmit at the specified period.
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Message period (in seconds)
Specify a period in seconds. This value is used to transmit the
message in the specified period. By default this value is 1.000
seconds.

See Also CAN Configuration, CAN Pack
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Purpose Unpack individual signals from CAN messages
. . .
lerclry CAN Communication
L L
Description
Signal1
DriverDoorLod
u AN M A Signalz File: demoVNT_CANdbFiles.dbc
CAN MegtiEssage: TAN Msg ~AN M Message: CAN Msg -
CAN Msg Standard ID: 250 Data CAN Mg Standard 10: 250 . CAN Msg Message: DoorControlMsg
Signal2 Standsrd 1D: 250
PassengerDoorlodk
Signal4
CAN Unpadk

(With raw data cutput)

CAN Unpade

CAN U ot
(With manuslly specified data output) nps

(With CANdE specified data cutput)

The CAN Unpack block unpacks a CAN message into signal data using
the specified output parameters at every timestep. Data is output as
individual signals.

Note To use this block, you also need a license for Simulink software.

The CAN Unpack block has one output port by default. The number
of output ports is dynamic and depends on the number of signals you
specify for the block to output. For example, if your block has four
signals, it has four output ports.

Signali

Meszage: CAN hisg Signalz

CAN M
" Standard I0:280  gignaiz

Signald

CAMN Unpack

Other Supported Features
The CAN Unpack block supports:
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® The use of Simulink Accelerator mode. Using this feature, you can
speed up the execution of Simulink models.

® The use of model referencing. Using this feature, your model can
include other Simulink models as modular components.

® (Code generation using Simulink Coder to deploy models to targets.

Note Code generation is not supported if your signal information
consists of signed or unsigned integers greater than 32-bits long.

For more information on these features, see the Simulink
documentation.
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Dialog
Box

Use the Function Block Parameters dialog box to select your CAN
message unpacking parameters.

E! Function Block Parameters: CAN Unpack (With raw dz 5'

—CAM Unpack

Unpack data from a CAM Message.

—Parameters
Data to be output as: ©
CANdb file: I Browse... |
Message list: |(none} LI
—Message
Mame: |CAN Msg
Identifier type: |Standard (11-bit identifier) ;I
Identifier: I 250

Length (bytes): I 8

—Output ports
[~ output identifier [~ Cutput tmestamp [~ Cutput error
[ output remate [~ output length ™ output status
CK I Cancel Help Apply
Parameters

Data to be output as
Select your data signal:

* raw data: Output data as a uint8 vector array. If you select
this option, you only specify the message fields. All other signal
parameter fields are unavailable. This option opens only one
output port on your block.

e manually specified signals: Allows you to specify data
signals. If you select this option, use the Signals table to
create your signals message manually.
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E! Function Block Parameters: CAN Unpack (With manually specified data output)

—CAM Unpack-

Unpack data from a CAN Message.

—Parameters

Data to be output as:

CANdb file: I Browse... |

Message list: I(none} LI
Messag
Mame: ICAN Msg
Identifier type: IStandard (11-bit identifier) j
Identifier: I 250

Length (bytes): I 8

Signals: Add signal Delete signal |
Start [Length |Byte |Data Multiplex Multiplex X
Name bit (bits) order value Factor |Offset |Min |Max
Signall 1] B|LE | |[signed LI Standard | o] 1 0| -Inf| Inf
Signal2 8 B|LE | |[signed LIIStandard hd o] 1 0| -Inf| Inf
Signal3 16 8|Le =llsianed  =|jstandard =] 0 1 0| Inf| Inf
Signald| 24 8jle w|jsigned  x|lstandard  ~| 0 1 0| dnf| Inf
—Output ports

™ output identifier [~ Output timestamp ™ output error
™ Output remote ™ Output length ™ Output status

oK I Cancel | Help | Apply

The number of output ports on your block depends on the
number of signals you specify. For example, if you specify four
signals, your block has four output ports.

CANdb specified signals: Allows you to specify a CAN
database file that contains data signals. If you select this
option, select a CANdD file.
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Note You can specify a CAN database file only on a Windows
32-bit machine.

E! Function Block Parameters: CAN Unpack (With CANdb specified data output) ﬂ

—CAM Unpack:

Unpack data from a CAN Message.

—Parameters

Data to be output as:

CANdb file: I CANdbFiles.dbc Browse... |

Message list: IDDDrConh’oIMsg LI
Messag
MName: I DoorCantrolMsg
Identifier type: IStandard {11-bitidemtifier) LI
Identifier: |4DD
Length (bytes): |8
Signals: Add signal Delete signal |
Name Ei‘frt E’E}H‘ E:’;:r E;:E gﬂ:de“ T;'f:'e" Factor |Offset |Min |Max
DriverD 1 LLE = |junsigned LI Standard x| 1] 1 1] 1] 1
Passeny| 0 1JLE _x Jjunsigned jlstandard hd 0 1 0 0 1
— Output ports
™ output identifier ™ Output timestamp ™ output error
™ Output remote ™ Output length ™ Output status

OK I Cancel | Help | Apply |

The number of output ports on your block depends on the
number of signals specified in the CANdb file. For example, if
the selected message in the CANdD file has four signals, your
block has four output ports.
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CANdb file
This option 1s available if you specify that your data is input via a
CAN(db file in the Data to be output as list. Click Browse to
find the appropriate CANdb file on your system. The messages
and signal definitions specified in the CANdDb file populate the
Message section of the dialog box. The signals specified in the
CAN(db file populate Signals table.

Message list
This option is available if you specify that your data is to be
output as a CANdD file in the Data to be output as list and you
select a CANdb file in the CANdDb file field. You can select the
message that you want to view. The Signals table then displays
the details of the selected message.

Message

Name
Specify a name for your CAN message. The default is CAN Msg.
This option is available if you choose to output raw data or
manually specify signals.

Identifier type
Specify whether your CAN message identifier is a Standard or an
Extended type. The default is Standard. A standard identifier
is an 11-bit identifier and an extended identifier is a 29-bit
identifier. This option is available if you choose to output raw
data or manually specify signals. For CANdb-specified signals,
the Identifier type inherits the type from the database.

Identifier
Specify your CAN message ID. This number must be a integer
from O through 2047 for a standard identifier and from 0 through
536870911 for an extended identifier. If you specify 1, the block
unpacks all messages that match the length specified for the
message. You can also specify hexadecimal values using the
hex2dec function. This option is available if you choose to output
raw data or manually specify signals.
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Length (bytes)
Specify the length of your CAN message from 0 to 8 bytes. If you
are using CANdb specified signals for your output data, the
CANGdb file defines the length of your message. If not, this field
defaults to 8. This option is available if you choose to output raw
data or manually specify signals.

Signals Table

This table appears if you choose to specify signals manually or define
signals using a CANdb file.

If you are using a CANdDb file, the data in the file populates this table
automatically and you cannot edit any fields. To edit signal information,
switch to manually specified signals.

If you have selected to specify signals manually, create your signals
manually in this table. Each signal you create has the following values:

Name
Specify a descriptive name for your signal. The Simulink block
in your model displays this name. The default is Signal [row
number].

Start bit
Specify the start bit of the data. The start bit is the least
significant bit counted from the start of the message. The start
bit must be an integer from 0 through 63.

Length (bits)
Specify the number of bits the signal occupies in the message. The
length must be an integer from 1 through 64.

Byte order
Select either of the following options:

® LE: Where the byte order is in little-endian format (Intel). In
this format you count bits from the start, which is the least
significant bit, to the most significant bit, which has the
highest bit index. For example, if you pack one byte of data in
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little-endian format, with the start bit at 20, the data bit table
resembles this figure.

Bit Number
—
g Bit 7 Bitb Bit5 Bit 4 Bit3 Bit2 Bitl Bit 0
=
3
=
o 7 3 5 4 3 2 1 0
>
0O Byte 0
s 15 14 13 12 11 10 3 8
o
(]
Byte 1
Byte 2
31 a0 29 28
Data begins at the least significant
Byte 3 bit and starts at 20
a9 as a7 a6 s 34 a3 3z
Data is writen up to the most significant
Byte 4 bit and ends at 27
47 a6 45 44 43 42 41 40
Byte §
55 54 53 52 51 50 43 43
Byte 6
63 62 &1 &0 59 58 57 56
Byte 7

Little-Endian Byte Order Counted from the Least Significant Bit
to the Highest Address

e BE: Where the byte order is in big-endian format (Motorola). In
this format you count bits from the start, which is the least
significant bit, to the most significant bit. For example, if you
pack one byte of data in big-endian format, with the start bit at
20, the data bit table resembles this figure.
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Bit Number
Bit7 Bité Bit5 Bitd| Bit3| Bit2| Bitl| Bit0

Data Byte Number

13 17
Data iswriten up to the most
significant bit and ends at |11

31 a0 29 27 26 5 24
Data begins at the least significant

Byte 3 it and starts at 20

a9 L a7 a6 as 34 a3 az
Byte 4

47 a6 45 44 43 42 41 40
Byte §

55 54 53 52 51 50 43 43
Byte 6

63 62 61 &0 59 58 57 56
Byte 7

Big-Endian Byte Order Counted from the Least Significant Bit
to the Lowest Address

Data type
Specify how the signal interprets the data in the allocated bits.
Choose from:

e signed (default)
® unsigned

e single

® double
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9-36

Multiplex type

Specify how the block unpacks the signals from the CAN message

at each timestep:

e Standard: The signal is always unpacked at each timestep.

® Multiplexor: The Multiplexor signal, or the mode signal is
always unpacked. You can specify only one Multiplexor signal

per message.

e Multiplexed: The signal is unpacked if the value of the
Multiplexor signal (mode signal) at run time matches the
configured Multiplex value of this signal.

For example, a message has four signals with the following values.

Signal Name Multiplex Type Multiplex Value
Signal-A Standard N/A

Signal-B Multiplexed 1

Signal-C Multiplexed 0

Signal-D Multiplexor N/A

In this example:

The block unpacks Signal-A (Standard signal) and Signal-D
(Multiplexor signal) in every timestep.

If the value of Signal-D is 1 at a particular timestep, then the
block unpacks Signal-B along with Signal-A and Signal-D in
that timestep.

If the value of Signal-D is 0 at a particular timestep, then the
block unpacks Signal-C along with Signal-A and Signal-D in
that timestep.

If the value of Signal-D is not 1 or 0, the block does not unpack
either of the Multiplexed signals in that timestep.
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Multiplex value

This option is available only if you have selected the Multiplex

type to be Multiplexed. The value you provide here must match
the Multiplexor signal value at run time for the block to unpack
the Multiplexed signal. The Multiplex value must be a positive

integer or zero.

Factor

Specify the Factor value applied to convert the unpacked raw
value to the physical value (signal value). See “Conversion
Formula” on page 9-38 to understand how unpacked raw values
are converted to physical values.

Offset

Min

Max

Specify the Offset value applied to convert the physical value
(signal value) to the unpacked raw value. See “Conversion
Formula” on page 9-38 to understand how unpacked raw values
are converted to physical values.

Specify the minimum raw value of the signal. The default value
is -inf (negative infinity). You can specify any number for the
minimum value. See “Conversion Formula” on page 9-38 to
understand how unpacked raw values are converted to physical
values.

Specify the maximum raw value of the signal. The default value
is inf. You can specify any number for the maximum value. See
“Conversion Formula” on page 9-38 to understand how unpacked
raw values are converted to physical values.

Output Ports

Selecting an Output ports option adds an output port to your block.

Output identifier

Select this option to output a CAN message identifier. The data
type of this port is uint32.
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Output remote
Select this option to output the message remote frame status.
This option adds a new output port to the block. The data type of
this port is uint8.

Output timestamp
Select this option to output the message time stamp. This option
adds a new output port to the block. The data type of this port
is double.

Output length
Select this option to output the length of the message in bytes.
This option adds a new output port to the block. The data type of
this port is uint8.

Output error
Select this option to output the message error status. This option
adds a new output port to the block. The data type of this port is
uint8.

Output status
Select this option to output the message received status. The
status 1s 1 if the block receives new message and 0 if it does not.
This option adds a new output port to the block. The data type of
this port is uint8.

If you do not select any Output ports option, the number of output
ports on your block depends on the number of signals you specify.

Conversion Formula

The conversion formula is

physical_value = raw_value * Factor + Offset

where raw_value is the unpacked signal value. physical value is the
scaled signal value which is saturated using the specified Min and
Max values.

See Also CAN Pack
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